Microsoft® MS-DOS®

User's Guide

VERSION 5.0

for the MS-DOS® Operating System

Microsoft Corporation
Microsoft. MS-DOS.

User's Guide

VERSION 5.0

for the MS-DOS® Operating System

Microsoft Corporation
Table of Contents

About Your MS-DOS 5.0 Documentation ...................................... xv

What's Included in This Guide? ............................................... xv
Conventions ............................................................................ xvi
Visual Cues .............................................................................. xvi
Keyboard Formats ..................................................................... xvii
Command Terminology ........................................................... xvii

PART 1 MS-DOS Fundamentals

Chapter 1 Getting Started ....................................................... 3
If You Have a Previous Version of DOS ...................................... 3
What You Need to Upgrade to MS-DOS 5.0 .............................. 3
Upgrading MS-DOS 5.0 .......................................................... 4
If Something Goes Wrong With a Hard-Disk Upgrade ................. 5
Recovering Your Original System After a Successful Upgrade .... 5
If You're Installing MS-DOS for the First Time ......................... 6
What You Need to Use MS-DOS ............................................... 6
Installing MS-DOS 5.0 ............................................................ 7
Creating a Backup Copy of MS-DOS ........................................ 8
If You Have Problems Running an Application ....................... 8
New Features of MS-DOS 5.0 .................................................... 8

Chapter 2 MS-DOS and Your System ..................................... 11
Your System Hardware ............................................................ 11
The Keyboard .......................................................................... 13
Disk Drives .............................................................................. 14
Main Memory .......................................................................... 18
Devices .................................................................................. 19
What Is MS-DOS? ................................................................... 19
Using Programs with MS-DOS ................................................ 19
PART 2 Working with MS-DOS

Chapter 5 Working with Files

Types of Files
Program Files
Specialized Data files
Unformatted Text Files
Formatted Text Files
Batch Files

Filenames
Names
Extensions

File Size and Time of Creation

Using MS-DOS Wildcards
Using Wildcards to Specify Groups of Files
Using Wildcards to Match Files

Displaying Text Files
Copying Files

Copying Single Files
Copying a Group of Files with Wildcards
Renaming as You Copy
Combining Files with the Copy Command
Contents

Copying from the Keyboard and to the Printer ............... 85
Copying Files with the Shell .................................. 86
Renaming Files .................................................... 86
Printing Text Files ................................................. 87
  Printing Files .................................................. 88
  Using the Print Queue ....................................... 89
Deleting Files ..................................................... 89
  Deleting Single Files ....................................... 90
  Deleting Groups of Files .................................... 90
  Clearing a Directory .......................................... 91
  Deleting Files with the Shell ............................... 91
Moving Files ...................................................... 91
Comparing Files .................................................. 92
Viewing and Changing File Attributes .......................... 93
  Viewing File Attributes .................................... 94
  Changing a File Attribute ................................... 94
Finding Text Within a File .................................... 96
Using the Shell to Search for Files ............................. 98
Using the Shell to Get Information About a File ............. 99
Using the Shell to Associate a File with a Program ......... 101

Chapter 6   Working with Directories ......................... 103

Understanding Directories ...................................... 103
  The Directory Tree ......................................... 103
  Directory Names ............................................. 106
  Paths and Pathnames ...................................... 106
  The Current Drive ......................................... 108
  The Current Directory ..................................... 108
  Using the Prompt Command to See the Current Directory .. 109
Viewing Directories .............................................. 110
  Displaying Whole Directories .............................. 111
  Displaying Groups of Files ................................ 112
  Arranging the Display of a Directory ..................... 112
  Sorting a Directory Listing ................................ 113
Viewing All Directories on a Disk .............................. 114
Viewing Directories in the Shell ................................ 115
Using the File Manager Directory Tree ....................... 116
Contents

Rearranging the Shell Display ........................................ 122
Modifying File Lists .................................................. 125
Creating Directories .................................................... 126
Moving Between Directories ........................................... 128
Finding Out Which Directory Is Current ............................ 128
Changing Directories ................................................... 129
Deleting Directories .................................................... 130
Copying Directories ..................................................... 132
  Copying All Files in a Directory .................................. 132
  Creating Directories as You Copy ................................ 133
  Copying Subdirectories ............................................. 134
  Renaming Directories .............................................. 134
Updating Directories .................................................. 136
  Replacing Outdated Files ....................................... 136
  Adding New Files ................................................ 136
Telling MS-DOS Where to Look for Files ............................ 137
  Using the Path Command ....................................... 137
  Using the Append Command .................................... 138

Chapter 7  Managing Disks ............................................. 141

Types of Disks .......................................................... 141
Bytes, Kilobytes, and Megabytes .................................... 143
Kinds of Disk Drives .................................................. 143
Formatting Disks ........................................................ 144
  Formatting a Single Disk ....................................... 145
  Formatting Different Disk Types ............................... 147
Creating System Disks ............................................... 148
Unformatted a Hard Disk ............................................. 149
Using the Shell to Format Floppy Disks ............................. 150
Labeling Disks .......................................................... 150
  Assigning and Deleting Labels ................................ 151
  Viewing Labels .................................................... 152
Making Backup Disks .................................................. 152
  Backing Up Single Directories ................................ 153
  Backing Up a Directory and its Subdirectories ............... 154
  Backing Up Selected Files .................................... 154
Adding Files to a Backup Disk ...................................... 155

Beta Release
Chapter 8  Advanced Command Techniques  ................. 183

Redirecting Command Output and Input  .................. 183
  Redirecting the Output of a Command  ................. 184
  Redirecting the Input to a Command  .................. 185
Passing Information Through Filter Commands ............... 185
  Controlling the Screen Display with the More Command 185
  Searching for Text with the Find Command ............... 186
  Sorting Text Files ........................................ 186
  Combining Commands with Redirection Characters ........ 187
Chapter 9  The Shell Program Manager .......................... 211

Working with Groups ............................................. 211
   Adding a Group .............................................. 214
   Changing a Group ........................................... 216
   Deleting a Group ........................................... 217
   Reordering a Group List .................................... 219

Working with Programs ........................................... 219
   Adding a Program to a Group ............................... 219
   Changing a Program ........................................ 222
   Removing a Program from a Group .......................... 223
   Copying a Program ........................................... 224

Creating Startup Commands for Your Programs ................. 225
   Using the Startup Directory Box ............................ 226
   Running Batch Files in a Startup Command ................. 227
   Using Parameters ............................................ 227
Chapter 10  Working with the MS-DOS Editor ................. 231

Getting Started with Edit ....................................... 231
Working with Menus ............................................. 233
Working with Dialog Boxes ..................................... 234
Getting Help ..................................................... 236
Exiting Edit ..................................................... 238
Creating a Text File .............................................. 238
Moving the Cursor ............................................... 238
Selecting Text .................................................. 239
Editing Text ..................................................... 240
Moving Text ..................................................... 240
Copying Text ................................................... 241
Clearing Text ................................................... 242
Finding Text .................................................... 242
Replacing Text .................................................. 243
Managing Files .................................................. 244
Creating a New File ............................................. 244
Opening a File .................................................. 244
Saving a File .................................................... 245
Printing a File .................................................. 246
Customizing Edit ............................................... 246
Controlling the Screen Display .............................. 246
Specifying the Help Path ...................................... 247

PART 3  Customizing MS-DOS

Chapter 11  Working with Batch Files ...................... 251

Understanding Batch Files ..................................... 251
Batch File Commands .......................................... 252
Tools for Creating Batch Files ............................... 253
Naming Batch Files ............................................ 253
Running Batch Files .......................................... 253
Stopping Batch Files ......................................... 254
Debugging Batch Files ....................................... 254
Undoing What You Have Done ................................ 254
The AUTOEXEC.BAT Batch File ......................... 255

Beta Release
Contents

Creating Small Batch Files ........................................... 255
Displaying Messages with the Echo Command ................. 256
Pausing a Batch File .................................................. 257
Including Remarks in a Batch File .................... 258
Starting Batch Files Inside Batch Files ................. 259
Using Replaceable Parameters ................................... 260
Controlling When Commands Run .............................. 261
   Using Goto ......................................................... 261
   Using If Commands ............................................. 262
   Using If and Goto Together ..................... 263
Creating a Batch File Menu System ....................... 264
   Making a Menu Item with Pause ................. 266
   Making a Menu Item with Replaceable Parameters .... 266
   Making a Menu Option with If and Goto ....... 268
   Exiting from the Menu System ................. 270

Chapter 12  Customizing Your System ............................ 271

Creating a Startup Procedure ................................. 272
   Startup Commands ............................................ 272
Sample Startup Procedures ..................................... 273
Configuring MS-DOS for Your System ..................... 275
   An Overview of the Configuration Commands .... 275
   Installing Device Drivers .............................. 276
   Increasing the File Transfer Area .................... 277
   Increasing the Number of Files You Can Have Open .... 277
   Increasing CTRL+C Checking ........................ 278
   Increasing the Number of Logical Drives ......... 279
Sample Configuration Files .................................... 279
Configuring Your Ports ........................................... 280
   Configuring Your Printer .................................. 281
   Configuring a Serial Port ............................... 282
Adding Disk Drives .............................................. 283
   Installing the Driver ....................................... 284
   Assigning Two Drive Letters to a Single Drive .... 286
   Redefining Drive A or B ............................... 286
Chapter 13  Optimizing Your System .......................... 301
  What Is Optimizing? .................................. 301
  What Are System Resources? ...................... 302
     Understanding Memory .......................... 302
     Understanding Disk Space ...................... 304
  Improving Your System's Speed .................. 305
     Using the Buffers Command .................. 307
     Using Fastopen ................................. 308
     Using SMARTDrive ............................. 309
     Using RAMDrive ................................ 314
     Using the HIMEM Extended Memory Manager .. 318
  Installing the EMM386 Expanded Memory Emulator .. 319
  Improving the Efficiency of Your Hard Disk .... 321
  Freeing Up Memory ................................. 330
     Freeing Up Conventional Memory ............. 330
     Freeing Up Extended Memory .................. 334
     Freeing Up Expanded Memory .................. 335

Chapter 14  Customizing for International Use ............ 337
  Understanding Languages .......................... 337
  Changing Conventions and Keyboards .......... 340
     Changing Date and Time Formats With the Country Command .. 340
     Changing Keyboards with the Keyb Command .... 342
  Using Code Pages .................................. 345
     Preparing Your Console for Code Pages .... 346
     Preparing Your Printer for Code Pages .. 348
     Preparing MS-DOS for Code Pages ............ 350
Contents

Loading Code Pages ............................................. 350
Changing Code Pages ........................................... 352
Displaying Code Page Information ............................. 353
Sample Language Changes ....................................... 354
  Changing Languages Without Changing Code Pages ........ 355
  Using One Prepared Code Page ................................. 355
  Using Two Prepared Code Pages with Your Console ........ 356
  Using Prepared Code Pages with Your Printer .............. 357
About Your MS-DOS 5.0 Documentation

The MS-DOS® 5.0 documentation set consists of this User's Guide, the MS-DOS 5.0 User's Reference, and online Help for MS-DOS and MS-DOS Shell commands.

The MS-DOS 5.0 User's Guide describes how you can work with MS-DOS. It includes information for user's who have little experience with computer systems, as well as advanced topics for those who are familiar with MS-DOS.

The MS-DOS 5.0 User's Reference contains complete descriptions of all commands and installable device drivers. These descriptions give intermediate and advanced users information about the full capabilities of MS-DOS. This book also contains a guide to MS-DOS messages.

Online Help with MS-DOS commands is a new feature of MS-DOS 5.0. You can get a quick summary of MS-DOS command syntax and options by typing a few characters on your keyboard. Online help with MS-DOS Shell commands also provides easy access to information about Shell procedures and commands.

What's Included in This Guide?

The MS-DOS 5.0 User's Guide provides an introduction to using the features of MS-DOS 5.0. Some features you'll use daily; others you'll use infrequently, if at all. You'll find features that you're likely to use most often described early in the book. Advanced features and tasks you'll occasionally need to do are presented in later chapters.

The MS-DOS 5.0 User's Guide is divided into the following parts:

Part 1. MS-DOS Fundamentals. Chapters in this part explain the essentials of a computer system and MS-DOS. They also explain how to use the MS-DOS command line and Shell.

Part 2. Working with MS-DOS. Chapters in this part describe the procedures for working with files, directories, and disks. It also explains advanced techniques for
using MS-DOS commands, tells you how to use the MS-DOS Shell Program Manager, and describes procedures for using the new MS-DOS full-screen editor.

Procedures in this part are briefly summarized at the beginning of each section to allow you to quickly review steps needed to accomplish a task. If you're using the MS-DOS Shell, you'll find Shell procedures, when they are relevant, at the end of sections.

Part 3, Customizing MS-DOS. Chapters in this part provide information for advanced users on using batch files, customizing your computer system, and using MS-DOS internationally.

Appendix. The appendix contains information about keyboard configurations for various countries.

Conventions

To help you locate and identify information easily, the MS-DOS 5.0 User's Guide uses visual cues, standard text formats, and special terms. These conventions are explained in the following sections.

Visual Cues

You'll find the following typographical conventions throughout the guide:

<table>
<thead>
<tr>
<th>Type style</th>
<th>Used for</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bold</strong></td>
<td>Command names, switches, and any text you must type exactly as it appears.</td>
</tr>
<tr>
<td><em>italic</em></td>
<td>Parameters. You must supply the text for any item shown in italic. For example, if you want to use a parameter that calls for a <em>filename</em>, you must type the name of the specific file. Italic type also indicates a new term. The term is always explained when it first occurs.</td>
</tr>
<tr>
<td>ALL CAPITALS</td>
<td>Directory names, filenames, and acronyms.</td>
</tr>
<tr>
<td>SMALL CAPITALS</td>
<td>The names of keys on your keyboard. For example, CTRL or ENTER.</td>
</tr>
<tr>
<td>MONOSPACE</td>
<td>Examples of commands and command output.</td>
</tr>
</tbody>
</table>
Type style
Initial Capitals
Used for
Program names, menu items, and dialog-box names and options. For example, Doskey, Copy menu, or Confirm on Delete option.

Symbol
Used for
▶
Indicates the beginning of a procedure.

Shell▶
In chapters not devoted exclusively to the MS-DOS Shell, indicates the beginning of a Shell procedure.

■
Indicates that a procedure has only one step.

Mouse
Instructions for mouse users.

Keyboard
Instructions for keyboard users.

Keyboard Formats

Key combinations appear as follows:

\[ \text{KEY1 + KEY2} \]

A plus sign (+) between key names means to hold down the first key while you press the second key. For example, Press CTRL+C means to hold down the CTRL key and press the C key. Then release both keys.

Command Terminology

The MS-DOS 5.0 User's Guide uses the following terms to describe commands and their use:

Term
Application
Meaning
A computer program used for a particular task, such as word processing.

Choose
To use a mouse or key combination to pick an item that begins an action in Edit or the MS-DOS Shell. (Contrast with select.)

Click
To quickly press and release the mouse button.
<table>
<thead>
<tr>
<th><strong>Conventions</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ARROW keys</td>
<td>The four arrow keys on your keyboard. Each arrow key is named for the direction the key points: UP ARROW, DOWN ARROW, RIGHT ARROW, and LEFT ARROW.</td>
</tr>
<tr>
<td>Double-click</td>
<td>To click the mouse button twice in rapid succession.</td>
</tr>
<tr>
<td>Drive</td>
<td>The name of a hard disk drive or floppy disk drive. You need to specify a drive name only if you are using a file that is not on the default drive. You never need to specify a drive name for an internal command.</td>
</tr>
<tr>
<td>Enter</td>
<td>To type a command or text and press the ENTER key.</td>
</tr>
<tr>
<td>Filename</td>
<td>The name of a file, including any filename extension.</td>
</tr>
<tr>
<td>Menu</td>
<td>A list of items in Edit or the MS-DOS Shell. Most menu items are commands.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Provides more information to a MS-DOS command, such as the location of a file, the destination of a command action, or specific values you want the command to use.</td>
</tr>
<tr>
<td>Path</td>
<td>The name of the directory and any subdirectories.</td>
</tr>
<tr>
<td>Pathname</td>
<td>Refers to drive, path, and filename. Pathname is used in cases where you're required to specify the location of a file, which might be anywhere on the system.</td>
</tr>
<tr>
<td>Select</td>
<td>To mark an item by highlighting it with key combinations or by clicking it with a mouse. Selecting does not initiate an action. After selecting an item, you choose the action you want to affect the item. For example, you might select a filename and then choose the Copy command to copy the file to another directory. (Contrast with choose.)</td>
</tr>
<tr>
<td>Switch</td>
<td>An optional control for a command. For example, the /r switch in the sort command causes the command to sort backwards (from Z to A). All switches begin with a slash (/).</td>
</tr>
</tbody>
</table>
Part 1
MS-DOS Fundamentals
Chapter 1  
Getting Started

Getting started with MS-DOS 5.0 is easy and straightforward. If you have a previous version of DOS, just follow the instructions described below for upgrading to MS-DOS 5.0. If you are installing DOS for the first time, read the procedure for first-time installations.

After you complete the upgrade or installation and begin using MS-DOS 5.0, you'll find it includes many improvements that make your job easier and more efficient. A description of new MS-DOS features concludes this chapter.

If You Have a Previous Version of DOS

If you have a version of DOS on your system, you can upgrade to MS-DOS 5.0 by following a few simple steps that start the upgrade procedure. A program called Install guides you through the upgrade. It evaluates your system to determine the version of DOS and type of equipment you have, asking you to verify information and make changes, if necessary. The program also offers you the choice of making a backup of your existing files before continuing with the upgrade.

If your system includes a hard disk and you have files with names identical to new MS-DOS 5.0 files, the upgrade procedure replaces the existing files with the new files. Before beginning the upgrade, be sure to backup files you want to save.

What You Need to Upgrade to MS-DOS 5.0

The minimum requirements your system needs to upgrade to MS-DOS 5.0 are:

- DOS 2.11 or higher
- At least 256K of memory
- If you’re upgrading onto a hard disk, at least 2.5 MB of free disk space
- If you’re upgrading onto floppy disks, see the requirements listed below.
If you're upgrading MS-DOS 5.0 onto floppy disks, you need to supply the following disks to complete the upgrade:

- For a 5.25-inch (360K) disk drive, you need four low-density disks which you label Startup, Support, Utility, and Shell.
- For a 5.25-inch (1.2 MB) disk drive, you need four low-density or high-density disks which you label Startup, Support, Utility, and Shell.
- For a 3.5-inch (720K) disk drive, you need two low-density disks which you label Startup and Utility.
- For a 3.5-inch (1.44 MB) disk drive, you need two low-density or high-density disks which you label Startup and Utility.

Be sure that the floppy disks you use are blank and unformatted, or that they contain information you do not want to keep. The upgrade program formats floppy disks, causing the information stored on them to be lost.

If you are upgrading onto a hard disk, you need to supply the following floppy disks:

- One floppy disk for a backup copy of your old DOS system. Label this disk the *Recovery disk*.
- If you want to back up your files, supply enough floppy disks to make backup copies. The upgrade program tells you approximately how many backup disks you'll need.
- A floppy disk set of your original DOS files. You'll need these files if both the upgrade program and the recovery program fail.

**Upgrading MS-DOS 5.0**

During the upgrade, you'll be asked to verify and provide information about the following:

- The manufacturer of the DOS currently installed
- The path specifying where you want the upgrade program to copy your new MS-DOS files
- Whether or not you want to install the Shell
- The video configuration of your system (e.g. CGA, VGA, or EGA)
To upgrade to MS-DOS 5.0

1. Switch on your system.
2. Put the Startup disk in floppy drive A: and close the drive door.
3. Type A: and press ENTER.
4. Type install and press ENTER.
5. Follow the instructions on the screen.

If you have questions about any of the procedures or options, you can request on-line Help by pressing the F1 key.

**NOTE** Do not try to upgrade MS-DOS 5.0 by copying files directly from the upgrade disks. The files are in a special form that make them unusable unless they are copied during the upgrade process.

If Something Goes Wrong With a Hard-Disk Upgrade

As you upgrade an existing hard disk, problems might occur that require you to recover your original DOS system. For example, there might be a problem with your system's hard disk or internal memory that does not allow the upgrade program to install the new files. Or you might have a power failure while the upgrade program is copying the new MS-DOS files. When something goes wrong during the upgrade, use the Recovery disk to continue the upgrade from the point at which the problem occurred.

If the upgrade program detects an error in your system's hard disk or memory that prevents MS-DOS 5.0 from working, the program displays a message that includes instructions for recovering DOS.

In rare cases, you might not be able to restore your original version of DOS using the Recovery disk. If this happens, repartition and format your hard disk using your original DOS. Then you can restore your entire hard disk, including the original version of DOS, from the set of backup disks you created at the beginning of the upgrade program.

Recovering Your Original System After a Successful Upgrade

After you complete your upgrade, you might find that some of your existing programs are not compatible with MS-DOS 5.0, and you need to restore your original DOS system.
If You're Installing MS-DOS for the First Time

To restore your original system after a successful upgrade:

1. Insert the Recovery disk in drive A.
2. Switch on your system.
3. Follow the instructions on the screen.

If the recovery program fails, you need to recover your original DOS system using your backup disks.

**CAUTION** If you try to restore your original DOS system after you have used MS-DOS 5.0 to create files on your hard disk, you will lose the information in the new files, and you might cause other problems in your system. If you want to restore your original DOS system, it is best to do so soon after you complete the upgrade.

If You’re Installing MS-DOS for the First Time

If you do not have DOS on your system, installing MS-DOS 5.0 is as easy as inserting a disk into your floppy disk drive and switching on your system. A program called Install guides you through the installation. First it evaluates your system to determine what kind of equipment you have. Then it copies MS-DOS files onto your hard disk or floppy disks, asking you to verify information and make changes when appropriate. If you’d like more information about disk drives and your system before beginning the installation, see Chapter 2, “MS-DOS and Your System.”

What You Need to Use MS-DOS

The minimum requirements your system needs to use MS-DOS 5.0 are:

- One of the Intel 8086 (or higher) family of processors
- If you are installing onto floppy disks, at least 256K of memory
- If you are installing onto a hard disk, at least 512K of memory and 2.5 MB of free disk space

If you are installing MS-DOS 5.0 onto floppy disks, you need to supply the following number of disks to complete the installation:

- For a 5.25-inch (360K) disk drive, you need four low-density disks which you label Startup, Support, Utility, and Shell.
For a 5.25-inch (1.2 MB) disk drive, you need four low-density or high-density disks which you label Startup, Support, Utility, and Shell.

For a 3.5-inch (720K) disk drive, you need two low-density disks which you label Startup and Utility.

For a 3.5-inch (1.44 MB) disk drive, you need two low-density or high-density disks which you label Startup and Utility.

Be sure that the floppy disks you use are blank and unformatted, or that they contain information you do not want to keep. The installation program formats them, causing the information stored on the disks to be lost.

**Installing MS-DOS 5.0**

During the installation, you'll be asked to verify and provide information about the following:

- The current time and date
- The country setting of your system
- Your keyboard and keyboard layout
- Whether you want to install MS-DOS 5.0 onto a hard disk or floppy disks
- The path that specifies where you want the MS-DOS 5.0 files to be located
- Whether or not you want to MS-DOS Shell to start automatically each time you start your system
- Whether or not to install the program that controls the Microsoft Mouse
- Whether or not to use all available disk space for MS-DOS 5.0
- The video configuration of your system (e.g. CGA, VGA, or EGA)

**To install MS-DOS 5.0**

1. Put the Startup disk in the floppy in drive A: and close the drive door.
2. Switch on your system.
3. Follow the instructions on the screen.

If you have questions about any of the procedures or options, you can request online Help by pressing the F1 key.
Creating a Backup Copy of MS-DOS

NOTE  Do not try to install MS-DOS 5.0 by copying files directly from the installation disks. The files are in a special form that makes them unusable unless they are copied during the installation process.

Creating a Backup Copy of MS-DOS

After you’ve upgraded to MS-DOS 5.0 or installed MS-DOS for the first time, create a backup set of floppy disks. This will enable you to reinstall MS-DOS 5.0 if something happens to your Upgrade or Install disks.

If You Have Problems Running an Application

If you run an application that displays a message indicating it is incompatible with MS-DOS 5.0, contact the manufacturer to get an updated version of the application.

If the manufacturer has not updated the application, use the server command described in the MS-DOS 5.0 User’s Reference.

New Features of MS-DOS 5.0

If you’ve used earlier versions of DOS, you’ll find many improvements in MS-DOS 5.0. One of the most significant is the new installation program, which guides you through each step of the installation and provides help whenever you need it.

After you’ve installed MS-DOS 5.0, you’ll find that your databases and spreadsheets can be bigger, and your editor can process more text. MS-DOS 5.0 requires less memory than early versions of DOS, allowing applications to run faster and more efficiently.

MS-DOS 5.0 includes a new Shell, an improved graphical interface that can be displayed on higher resolution screens than before. The Shell allows you to manage programs easily, to group files, and to navigate among them quickly. It also enables you to work with larger disks than before.

If you choose to use the MS-DOS command line instead of the Shell, you’ll have on-line help on all MS-DOS commands at your fingertips.
You'll find QBASIC, an improved, easy-to-use BASIC programming environment that includes extensive on-line help. To use QBASIC, simply enter qbasic at the command prompt.

Using other MS-DOS 5.0 features and improvements, you can:

- Recall, edit, and run commands you've used previously. You can also define shortcuts for frequently used commands.
- Easily create and modify text files with a new full-screen editor.
- After formatting a disk, restore it to its former state.
- Sort directory listings by filename, type of file, time files were created, and file size.
- Search for files through multiple levels of directories.
- Use more than two hard-disk drives.
- Use disk partitions up to 2 GB.
- Use 2.88 MB floppy disks.
Chapter 2
MS-DOS and Your System

MS-DOS 5.0 is part of a computer system that includes hardware and software. Hardware is all the physical components of your system, including the computer, the monitor, the keyboard, and so on. Software is the information and instructions your system uses to perform the tasks you want it to do. MS-DOS is a special kind of software. It controls how the system processes instructions, how the system manages resources such as the time needed to accomplish a task, and how the pieces hardware communicate with one another.

Your System Hardware

The following illustration shows the basic hardware components of all personal computer systems. Your system may look somewhat different, but it will have the same basic parts.
This artwork is not available for this release.

- The computer contains the central processing unit (CPU) and main memory. The CPU processes information and instructions; the main memory stores information for short periods of time.
- Communications ports are outlets on the back of the computer. You use them to connect equipment to the system, such as a printer or a modem.
- Disk drives are located in the front of the computer. Your system uses the disk drives to store large amounts of information for long periods of time.
- You use the keyboard and the mouse enter information into the computer and to tell it to perform tasks.
- The monitor (also called a console) displays information you provide the computer and shows you what the computer does with the information.
The Keyboard

Your system's keyboard looks very much like a typewriter's. However, your system's has some additional keys.

The following illustrates these additional keys on a representative keyboard.

This artwork is not available for this release.

<table>
<thead>
<tr>
<th>Use this key</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL (control)</td>
<td>You use CTRL with other keys to allow them to have more than one function.</td>
</tr>
<tr>
<td>ALT</td>
<td>Like the CTRL key, ALT enables other keys to have more than one meaning.</td>
</tr>
</tbody>
</table>

Beta Release
**Your System Hardware**

<table>
<thead>
<tr>
<th>Use this key</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESC (escape)</td>
<td>You press ESC when you want to cancel something you’ve done.</td>
</tr>
<tr>
<td>DEL (delete)</td>
<td>You use DEL to delete (erase or remove) text.</td>
</tr>
<tr>
<td>INS (insert)</td>
<td>You use INS to insert text.</td>
</tr>
<tr>
<td>ARROW keys</td>
<td>You use these keys to move around the screen as you enter information.</td>
</tr>
<tr>
<td>NUMLOCK</td>
<td>You press this key when you want to use the numeric keyboard.</td>
</tr>
<tr>
<td>PAUSE</td>
<td>You use this key to stop what the computer is doing temporarily (not all keyboards have this key). If your system doesn’t have a PAUSE key, you can pause your computer by pressing CTRL+NUMLOCK.</td>
</tr>
<tr>
<td>BREAK</td>
<td>You use this key to cancel what the computer is doing. In the preceding illustration, the BREAK key label is on the front side of the PAUSE key. To use the BREAK key on this keyboard, you press CTRL and the key labelled BREAK at the same time. BREAK on your keyboard may be part of another key, or it may be a separate key.</td>
</tr>
</tbody>
</table>

**Disk Drives**

Much of the data and instructions your computer uses is on magnetic disks that can store information for long periods of time. Your system’s disk drives transfer information from the disks to the computer and back again as needed. Your system may have only one disk drive, or it may have several. Each is named by a single letter: A, B, C, and so on.

There are two main types of magnetic disks: floppy disks and hard disks. Each uses a different kind of disk drive.

**Floppy Disks and Floppy Disk Drives**

A floppy disk is a flexible, magnetized vinyl disk. Floppy disks come in two sizes; they are either 5.25 inches or 3.5 inches wide. The following illustration shows what a 5.25-inch floppy disk looks like:
This artwork is not available for this release.

int_3

Each disk is enclosed in its own protective cover. The front of this cover is smooth, while the back has visible seams.

Store your disks in a safe place, away from dust, moisture, magnets, and extreme temperatures. Be sure to label each disk to identify the information stored on the disk. Place labels on the front of the cover, at the top, so that the label doesn’t touch the magnetic surface of the disk or cover the notch on the side. It’s also a good idea to use a felt-tip pen when writing on labels—a pencil or ballpoint pen can damage the disk if you press too hard.
This artwork is not available for this release.

int_4

Labels help you keep track of the information on your disks. You might also need to protect the information on a disk so that it can't be changed. Some disks allow you to examine the information on them, but won't let you change the information. These are called write-protected disks.

The 5.25-inch disks can be write-protected in one of two ways. Some have a small piece of tape, called a tab, covering a notch on the right side of the disk. You can copy information onto a write-protected disk by first removing the write-protect tab. Before you do this, though, you should consider why the disk was protected, and ask yourself if you really need to change the information on it. When you finish working with a write-protected disk it's always a good idea to replace the write-protect tab.
If a disk does not have a write-protect notch, it is permanently write-protected. Many programs come on permanently write-protected disks that prevent the information on the disks from being destroyed accidentally.

The MS-DOS 5.0 operating system also allows you to use 3.5-inch disks, which, like 5.25-inch disks, are portable magnetic disks. Data on 3.5-inch disks is more densely packed. Depending on its capacity, a single 3.5-inch disk can store as much (or more) data as a 5.25-inch disk.

This artwork is not available for this release.

Int_5

The 3.5-inch disks have rigid plastic covers with metal shields that guard the disk from dirt and fingerprints. When you place the disk into the disk drive, the computer automatically moves this shield aside to read the disk.
Notice that 3.5-inch disks have a write-protect hole. This hole can be covered by sliding a built-in tab over it. When the write-protect hole is covered by the tab, the information on the disk can be changed.

Be sure to label your 3.5-inch disks and store them in a safe place. As with 5.25-inch disks, extreme temperatures, magnetism, dust, and fingerprints can harm a 3.5-inch disk.

**NOTE** MS-DOS works virtually the same way with 3.5-inch and 5.25-inch disks. In this guide, the term floppy disk refers to either of these two disk types.

Your system should have at least one floppy disk drive. When you want your computer to store or retrieve information on a 5.25-inch disk, you slide the disk into the floppy disk drive’s narrow slot, and close the drive door (this is usually a lever, hatch, or button on the front of the disk drive). When you are through using a disk, open the drive door and slide the disk out again.

To use a 3.5-inch disk, slide the disk into the disk drive slot until you hear a click. When you are through with the disk, press the button on the front of the drive, and the disk will pop out again.

If a system has one floppy disk drive, it is usually named A. If there are two floppy disk drives, they are usually named A and B.

**Hard Disks and Hard Disk Drives**

In addition to floppy disk drives, some systems have a hard disk and a hard disk drive. A hard disk is a magnetic disk that can store much more information than a floppy disk. Computers take less time to find information stored on a hard disk than on a floppy disk.

A hard disk is usually built into the computer. The hard disk and the hard disk drive are a single unit, so a hard disk can’t be removed like a floppy disk. A hard disk is sometimes called a *fixed disk*. A hard disk drive is usually named C.

**Main Memory**

While a computer can store and retrieve information on floppy and hard disks, it can only work with information that is stored in its own main memory. This memory is called Random Access Memory (RAM). When the computer needs information from a disk, it copies the information into its main memory. The information in RAM is lost when you shut your system’s power off. If you want to
keep the information you have been working with, it is important to save it on a floppy or hard disk before you turn your computer off.

**Devices**

Your system has at least three devices: a keyboard, a monitor, and one or more disk drives. Other common devices include printers (for printing information from your computer), modems (for transferring information between computers), and scanners (for converting images into information a computer can use). When you add a device to your system, MS-DOS needs to know about it. To find out more about MS-DOS and devices, see Chapter 12, “Customizing Your System”.

**What Is MS-DOS?**

The hardware introduced in the previous section exists so you can work with information. Instructions your computer needs to process information are called software because it consists of electronically coded information. Unlike hardware, which is tangible equipment, circuits, and devices, software is intangible. Unlike hardware, which you infrequently change, software easily and often changes in your system.

How can the tangible, physical hardware interact with the intangible, conceptual software? The two need something to facilitate communication between them. This is what MS-DOS does. MS-DOS allows hardware to work with software, making it possible for information to be entered, transferred, processed, displayed, and stored by the system. Software that performs these tasks is called an *operating system*.

**Using Programs with MS-DOS**

One of the operating-system tasks of MS-DOS is to control how and when the computer processes programs. Programs are sets of computer instructions stored on a disk. A program can perform simple jobs, such as the MS-DOS program that tells the computer the date and time. Most of the programs you’ll be using are far more complex, and contain many thousands of instructions. Here are some examples of programs, and their uses:

- You can use a word processing program to create and rearrange written documents such as letters, memos, reports, and books.
Organizing Information with MS-DOS

- You can use a spreadsheet program to create a financial balance sheet. The program can also do calculations and other tasks for you.
- You can use a database management program to create, store, and retrieve hundreds of thousands of records—for example, mailing lists, customer information, and sales figures.

Complex programs like these are often called *applications*.

To use a program, you tell MS-DOS to transfer the program from the disk where it is stored into the computer’s main memory. Once the program is in memory, MS-DOS hands control of the computer over to the program. The computer now follows the program’s instructions, and you can use it to write, enter data, or do any other work you need to do.

When you tell MS-DOS to transfer a program and turn the computer over to the program’s control, you are *running*, or *executing*, the program. While the program is running, MS-DOS is always in the background, helping the program transfer information to and from the system’s disks as needed.

Organizing Information with MS-DOS

When it is helping a program work, you don’t see MS-DOS in action. What you see instead on your monitor is information and instructions from the program that’s running. You work directly with MS-DOS itself when you want to use its tools for organizing information. To use these tools, you first need to understand that MS-DOS organizes information into files, directories, and disks.

Files

All information your computer uses must be contained in a file. A *file* is a collection of related information, like the contents of a file folder in a desk drawer. File folders, for instance, might contain business letters, office memos, or monthly sales data. The information in programs is also contained in files. The file allows MS-DOS to locate the information and pass it along to the computer when it’s needed. As this illustration shows, many files, each with its own information, can be contained on one disk:
This artwork is not available for this release.

Just as each folder in a file cabinet has a label, each file on a disk has a name.

You'll find more information about files, and how to organize and arrange them using MS-DOS tools, in Chapter 5, "Working With Files".

**Directories**

A floppy disk can have several hundred files on it, and a hard disk can have several thousand. Since it's difficult to keep track of so many files, MS-DOS gives you a way to group files together, so they are easier to find. These groups of files are called *directories*. Each directory has a name that can identify the group of files in it.
You can also create directories inside other directories. These are called subdirectories. Subdirectories allow you to classify your files into as many groups and subgroups as you need. The entire structure of directories and subdirectories is called the *directory tree*.

The directory you are working in is called the *current directory*, and from it you can move to other directories. You’ll find that MS-DOS directories will become more and more useful to you as you create and use more and more files. In Chapter 6, “Working With Directories”, you’ll find more information about directories and how to use them.

**Disks**

MS-DOS stores files and directories on floppy and hard disks. But before it can store information, you must prepare the disk. You do this with a special program that *formats* a disk so that MS-DOS can find information on it. When you format a disk, MS-DOS checks it for defects.

When a disk is formatted, MS-DOS automatically creates one directory on it. This directory, which begins the directory tree, is called the *root directory*. If you wish, you can create many other subdirectories on the disk.

Because disks can be damaged, it is important to make extra copies of the files you store on disks. These copies are called *backup* copies. Backup copies also protect you from losing information if someone inadvertently deletes a file or group of files. For information on backing up files, see Chapter 7, *Managing Disks*.

**The Command Line and the Shell**

What you see when you start MS-DOS depends on the way it is installed. You might see this on your screen:
This artwork is not available for this release.

Int_7

This is the MS-DOS command line. The symbol at the bottom of this monitor is called a command prompt. You type commands here to tell MS-DOS what to do.

Unless you tell it to do otherwise, MS-DOS automatically displays the Shell:
This artwork is not available for this release.

MS-DOS allows you to choose how you want to give it instructions. If you like to see things laid out for you, with all your choices displayed, you may prefer to use the Shell. If you like to tell MS-DOS what to do by typing commands, you might prefer to use the command line.

**The MS-DOS Command Line**

MS-DOS indicates the command line by displaying a command prompt on the screen:

```
C:\>
```

or

```
A:\>
```
or some variation, like this:

\texttt{C: \\d\d\s>}

To tell MS-DOS to do something, you type a command and press ENTER. Letters of the command appear to the right of the command prompt as you key them in.

For example, to display the list of files in a directory, type the following and then press ENTER:

\texttt{dir}

You can use this guide and \textit{MS-DOS 5.0 User's Reference} to help you determine the correct form of the command that you want to use. For more information about the MS-DOS command line, see Chapter 3, "Command Line Basics".

**The Shell**

Unlike the command line, the Shell graphically displays commands on the screen in \textit{menus}. You use the keyboard or a mouse to select a menu and choose the command you want.

If you want to change the name of a file from \texttt{FROGS.TXT} to \texttt{TOADS.TXT}, you select \texttt{FROGS.TXT} in the file list and choose the \textit{Rename} command from the File menu. A box then appears on the screen, asking you to type the new name of the file. After you do so, you press ENTER, and the file is renamed.

For more information about the Shell, see Chapter 4, "Shell Basics".

**Switching Between the Shell and the Command Line**

If you are using the command line and want to change to the Shell, enter:

\texttt{doshell}

If you are using the Shell and want to use only the command line, press the F3 key until you return to the MS-DOS command prompt. See Chapter 12, "Customizing Your System," for information about bypassing the Shell when you start your system.
Chapter 3

Command Line Basics

You use the command line to tell MS-DOS what you want it to do. MS-DOS indicates the command line by displaying the command prompt. Commands typed to the right of the prompt tell MS-DOS the task to perform. For example, you can tell MS-DOS to display its software version number by doing the following:

1. Type ver.
   Notice that the ver command appears at the command prompt.
2. Press ENTER.
   MS-DOS displays its software version number.

In this guide the sequence of typing a MS-DOS command and pressing ENTER is called entering a command.

Each command gives MS-DOS a set of instructions. For example, when you enter the ver command, you instruct MS-DOS to display a message with information about its version.

A command may be a word (like time) or a special abbreviation (like dir). You don’t need to worry about learning commands yet. For now, the important thing is to remember that each MS-DOS command does a particular task.

Parts of a Command

Whether a MS-DOS command performs a simple or complicated task, the command has no more than three parts. Every command has a command name. The command name is like a verb; it states the action that you want MS-DOS to perform. In addition to a name, some commands require a parameter that identifies the object you want MS-DOS to act upon. Finally, some commands include switches, which modify the action being performed.
The Command Name

The command name tells MS-DOS what action you want to do (delete a file, for example). You always type the command name first. Some commands, like cls consist only of the command name (this command clears previous commands or other information from your screen).

Most MS-DOS commands, however, require more than a name.

Parameters

MS-DOS sometimes requires additional information that you specify in one or more parameters after the command name. A parameter defines the object you want MS-DOS to act upon. For example, the del command, which tells MS-DOS to delete a file, requires a parameter that names the file you want to delete. Suppose, for example, you want to delete a file named SPINACH.DOC. Here’s what you enter:
This artwork is not available for this release.

Some commands require more than one parameter. For example, to rename a file with the ren command, you must include the original name of the file you want to rename, as well as the new name.

The following command changes the name of LETTER.TXT to MEMO.TXT:
This artwork is not available for this release.

cbl_2

With some commands, you have the option of using a parameter, depending on what you want to accomplish. For example, you can use the dir command without a parameter to list files in the directory you are currently using. Or, you can include a parameter (a different drive, for example) to list a directory on a different drive.

Switches

A switch is a forward slash (/) followed by a single letter or number. You use switches to modify the way a command performs a task. For example, you can tell MS-DOS to verify that you want to delete a file, or display a directory in a form that may be easier to use.
Suppose you want to use the dir command to view a listing of a directory with a large number of files in it. When you enter the dir command by itself, the files of a large directory scroll by so rapidly that you can’t read all the filenames. If you add a switch, /p, you can display files one screen at a time.

Switches vary from command to command. Some MS-DOS commands do not have any, while others have several. If a command has more than one switch, you can turn on more than one switch at a time by typing the switches one after the other, with a space between each.

You will probably not use switches very often when you first start using MS-DOS. When you have become more experienced with MS-DOS, you will find that switches can be very helpful. See Part II, “Using DOS,” for more information about the switches you can use with each command.

**Typing Commands**

To the right of the greater than sign (>) on the command line is the *cursor*. The cursor shows you where you can key in commands. When you type a character it appears where the cursor is, and the cursor moves one space to the right. If you make a mistake when you type, press the BACKSPACE key to delete characters to the left of the cursor. Try typing characters at the command prompt, and use the BACKSPACE key to delete them.

If you want to type the command from the beginning, press the ESC key. The cursor moves to the beginning of the next line, and you can start over again. MS-DOS ignores anything that you typed before you pressed ESC.

**Shortcuts to Typing Commands**

MS-DOS includes editing keys that allow you to modify or repeat commands you’ve already typed.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press this key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retype one character at a time</td>
<td>F1 (or the RIGHT ARROW key) from the previous command</td>
</tr>
<tr>
<td>Retype all of the previous command</td>
<td>F3</td>
</tr>
</tbody>
</table>

Suppose you want to see a directory listing of the disk in drive A:

1. Be sure that there is a floppy disk in drive A, and that the drive door is closed.
2. Enter dir a: #
   Since there is an extra character at the end of this command, MS-DOS displays
   a "File not found" message. You can use the F3 key to repeat and correct the
   command without having to retype it.

   MS-DOS retypes the command.

4. Press BACKSPACE once to erase the #.

5. Press ENTER.
   MS-DOS displays the directory listing.

Suppose you want to retype the same command, substituting drive B for drive A.
You can use the F1 key to retype the first part of the original command one
character at a time, change the a to b, and use F1 again to retype the rest.

1. Press F1 four times.
   The first part of the command, dir, appears.

2. Type b

3. Press F1 once.
   The colon (:) appears.
   If your system has a B drive, press ENTER to see a directory listing. Otherwise,
   press ESC.

For more information about editing keys, see Chapter 8, "Advanced Command
Techniques".

In addition to editing keys, MS-DOS includes a utility called Doskey that allows
you to retrieve, modify, and reuse commands. To start the utility, enter the doskey
command at the MS-DOS command prompt. The following message appears:

   Doskey installed

**NOTE** If you see a "File not found" message when you enter the doskey command, see
Chapter 8, "Advanced Command Techniques", for instructions about using Doskey.

Doskey remembers the commands you type, and allows you to retrieve and edit
them. For example, suppose you enter these three commands.

    del tuesday
date
time
The first command tells MS-DOS to delete a file named TUESDAY; the second displays the current date; the third displays the current time. All these commands are stored in your system's temporary memory. You can use several methods to retrieve one of them.

The easiest method is to press the UP ARROW key. If you press the UP ARROW key once, the most recent command (time) appears at the command prompt. Press UP ARROW two more times to return to the first command:

```
del tuesday
```

Now you can press ENTER to enter the command again.

You can edit the command before you enter it. For example, press HOME to move the cursor back the beginning of the line, and type the `ren` (rename) command over the `del` command. Then you can press END to move the cursor to the end of the line, press the SPACEBAR, and type a new name for the file: MONDAY. The edited command looks like this:

```
ren tuesday monady
```

To enter the revised command, press ENTER.

**How MS-DOS Responds to Commands**

MS-DOS responds in various ways to the commands you enter. You might see a display or message telling you that the command has been successfully completed. Or, MS-DOS might ask you for more information, or display a message telling you that you didn’t type the command correctly.

When you type some commands, MS-DOS asks for more information by displaying a prompt. For example, if you type the `time` command, MS-DOS displays the following prompt:

```
Current time is: 9:52:18
Enter new time:
```

In response, you enter the information requested, in this case the new time.

Sometimes MS-DOS will verify that you really want to do what you asked. For example, suppose you use the `del` command with MS-DOS wildcards described in Chapter 5 to delete all files in a directory:

```
del *.*
```

MS-DOS displays the following message:
Pausing or Canceling a Command

All files in directory will be deleted:
Are you sure (Y/N)?

If you realize that you don’t want to delete all files, you can enter n. MS-DOS will return to the command prompt without deleting the files. If in fact you want to delete all files, enter y. MS-DOS will go ahead and delete the files.

Sometimes MS-DOS displays the results of a command. For example, when you enter the copy command, MS-DOS displays the name of the file or files copied. If you entered a command telling MS-DOS to make a copy of three files named JAN.DOC, FEB.DOC, and MAR.DOC, you would see the following display.

```
JAN.DOC
FEB.DOC
MAR.DOC
3 file(s) copied
```

This display, and other displays like it, gives you a chance to make sure that the command you entered has been performed correctly.

Sometimes MS-DOS displays an error message indicating that it didn’t understand the command you entered. If you get an error message, reenter the command with a /? switch to get online help with the command. Or, look in Part Three of the MS-DOS 5.0 User’s Reference for ways to correct the error.

Pausing or Canceling a Command

You can tell MS-DOS to pause what it is doing temporarily by pressing CTRL+S or the PAUSE key. If you use PAUSE, press the key again to resume the command; if you use CTRL+S, press any key. You can stop and restart a command as many times as you want.

If you enter a command and then realize that you want to stop MS-DOS from completing it, press CTRL+BREAK or CTRL+C. These key combinations tell MS-DOS to stop what it’s doing and return to the command prompt.

NOTE Anything MS-DOS has done before you press CTRL+BREAK or CTRL+C cannot be undone.

Telling MS-DOS Which Disk Drive to Use

MS-DOS needs to know which disk drive to use. The disk drive that MS-DOS uses automatically is called the current drive. MS-DOS always uses one drive as the current drive. You can tell which drive is the current drive by looking at the let-
ter at the beginning of the MS-DOS command prompt. On most systems, if the letter is A (or B), one of the floppy disk drives is the current drive. If the letter is C, the hard disk drive is the current drive. Some systems have drives with other letters as well (these are usually hard disk drives, or special kinds of drives).

As long as the files or directories you want to work with are on a disk in the current drive, you do not need to tell MS-DOS which drive to use; MS-DOS assumes the current drive. If the files or directories are not located on the current drive, you can either specify the drive as part of a command or change the current drive.

To specify a drive other than the one that’s current, include the drive letter in the command parameter. For example, suppose the current drive is C. To list the files on the disk in drive A, include the A drive as a parameter in the dir command:

```
  dir a:
```

This command tells MS-DOS to list the files in drive A. Notice that the drive letter in this command must be followed by a colon.

To change the current drive, enter the letter of the drive followed by a colon (:). For example, to change the current drive from C to A, enter:

```
  a:
```

As a result, MS-DOS automatically uses drive A.

**Internal and External Commands**

MS-DOS automatically loads some commands into memory when you switch on your system. These *internal* commands are included in the main part of MS-DOS. Internal commands include dir, del, date, and time. MS-DOS stores other *external* commands in files on disk and transfers them from disk to memory as you need them. You can determine whether a command is internal or external by consulting its description in the *MS-DOS 5.0 User's Reference*.

When you install MS-DOS 5.0, it places external command files in a location it can find. If you move the files, make sure you tell MS-DOS their new location by using the path command described in Chapter 6, "Working With Directories".
Chapter 4
Shell Basics

The Shell is a graphical interface to MS-DOS. You can use the Shell to organize files and directories, make backup copies of files, run programs, and perform most other MS-DOS tasks. By using the Shell, you can list and choose options from menus. The Shell also gives you a visual display of the directories and files on your disk drives. This makes it easy for you to move from one directory to another, and to choose specific files to work with. You can also use the Shell to put programs into groups to make them easier to find and use.

Starting the Shell

Depending on the way MS-DOS was installed on your system, you start the MS-DOS Shell in one of three ways.

If you have a hard disk system, and you see the Shell screen when you switch on your system, the Shell is set up to run whenever you start your system.
This artwork is not available for this release.

shb_1

If you have a hard disk system, and you see the command prompt when you switch on your system, start the Shell by entering dosshell.

If you have a floppy disk system, start MS-DOS using the STARTUP disk. When the command prompt appears, insert the SHELL floppy disk into drive A:, enter dosshell. After a few moments the Shell screen appears.

If you are using a mouse with the Shell, make sure that you install MOUSE.COM before invoking the Shell.

Understanding the Shell and Its Screens

The first time you start the MS-DOS Shell, you see Program Manager. You use Program Manager to run programs and organize them into groups.
This artwork is not available for this release.

shb_2

To work with files and directories, you use File Manager.
This artwork is not available for this release.

shb_3

You'll learn more about both these components of the Shell later in this chapter.

Shell Screen Elements

Both Program Manager and File Manager have some basic screen elements in common. The following illustration shows you these basic elements as they appear on the Program Manager screen.
This artwork is not available for this release.

shb_4

The title bar shows you the name of the screen you are working with (Program Manager or File Manager), along with the current date and current time. The menu bar shows you the names of the available menus. When you select a menu, it displays a list of commands you can choose from. The selection area displays the programs, files, and directories you work with in the Shell. You use the selection cursor to select programs, files, or directories from the selection area, and to choose commands from menus. The key definition line displays information about function keys you can use to perform basic tasks. You will learn how to use these screen elements later in this chapter.

Text Mode and Graphics Mode

The Shell appears on your screen in one of two modes: graphics mode or text mode.
Graphics mode displays the Shell with graphic symbols, called *icons*. To use graphics mode, your system's monitor must be CGA, VGA, or EGA.

In graphics mode, Program Manager looks like this:

```
This artwork is not available for this release.
```

```
shb_5
```

Text mode displays the Shell without icons. You can choose to display the shell in text mode, even if your screen can display graphics mode. You can move through lists of files and directories more quickly in text mode.

In text mode, Program Manager looks like this:
This artwork is not available for this release.

You can choose among several variations of both text mode and graphics mode, depending on the number of lines you want to display on your screen. For information about switching between graphics mode and text mode, see "XX", later in this chapter.

The illustrations and explanations in this guide refer to graphics mode. The guide notes significant differences between text mode and graphics mode.

**Using the Keyboard with the Shell**

You can use either the keyboard or a mouse to work with the Shell. If you use the keyboard, you can use the keys in the following list to move around on the Shell screen, select menus, choose commands, and get Help when you need it.
To do this
Move the selection cursor.
Complete a command.
Cancel the selection of a menu or dialog box.
Show Help information for any topic you select.
In Program Manager, save the information typed into the
text box of a dialog box. You also press F2 to copy a pro-
gram to another group.
Exit from the File Manager screen to the Program
Manager screen or from the Program Manager screen to
the MS-DOS prompt.
Display the key assignments within a Help information
box. Within the View command, F9 switches you from
ASCII to hexadecimal format.
Move the selection cursor between the menu bar and the
selection area of your screen.
Display an index of Help topics.
Return to the command prompt.

Press these keys
ARROW keys,
TAB, or
SHIFT+TAB
ENTER
ESC
F1
F2
F3
F9
F10 or ALT
F11
SHIFT+F9

Working with the Shell

The Shell provides a graphical environment for running programs and performing
MS-DOS file-management tasks. To use the Shell, you need to know how to
choose commands from menus and how to give MS-DOS specific instructions
using dialog boxes.

Working with Menus

Much of your work with the Shell involves choosing commands from menus.
When you start working with a Shell screen, you see the names of the menus dis-
played in the menu bar near the top of the screen. When you open a menu, you see
a list of commands. The following example shows the commands in the File menu
in File Manager.
This artwork is not available for this release.

shb_7

Selecting a Menu
To open a menu and see its commands, you select the menu you want to use. Once you have selected a menu, you can choose a command from it.

To select a menu:

Mouse
- Click the name of the menu.

Keyboard
1. Move the selection cursor to the menu bar by pressing F10 or ALT. In File Manager, you can also press the TAB key or SHIFT+TAB one or more times to do this.
2. Use the LEFT ARROW and RIGHT ARROW keys to move the selection cursor to the menu you want, and press ENTER or DOWN ARROW. You can also press the highlighted letter in the menu name.

Once you have selected a menu with either the mouse or the keyboard, you can move from one menu to the next using the RIGHT and LEFT ARROW keys.

**Choosing a Command from a Menu**

Instructing the MS-DOS Shell to perform an action is called *choosing* a command. You must select a menu before you can choose a command.

When you select a menu, some of the commands on it may be only faintly visible. These commands are temporarily unavailable. If you want to use one of these commands, you first need to select a file or a directory, or perform some other action.

➤ **To choose a command from a selected menu:**

**Mouse**
- Click the name of the command.
  - Or drag the highlight to the command and release the mouse button.

**Keyboard**
- Use the ARROW keys to move to the command you want, and press ENTER.
  - Or press the highlighted letter of the command. For example, to choose Copy from the File menu, press C.

➤ **To select a menu and choose a command in one step:**

1. Point to a menu name and hold down the mouse button.
2. Drag the highlight to the command you want and release the mouse button.
   - If you don’t want to choose a command, drag the mouse cursor outside the menu before you release the mouse button.

**Canceling a Selection**

If you select a menu and then decide you don’t want to use it, you can cancel the selection by pressing ESC or F10, or by clicking anywhere outside the menu on the Shell screen.
Working with Dialog Boxes

To perform many of the commands in Shell menus, MS-DOS needs information from you. For example, if you want to rename a file, MS-DOS needs to know the new name of the file.

Entering Information in a Dialog Box

When you choose an MS-DOS command that requires additional information, a dialog box appears. Each dialog box asks for different information. For example, when you choose Rename from the File menu, the Shell displays the following dialog box.

This artwork is not available for this release.

shb_8
Like most other dialog boxes, the Rename File dialog box includes a smaller text box where you can type information. In this case, you type the new name of the file in the “New name” box. A cursor marks where you can type text. As you type, characters appear in the text box and the cursor moves to the right. In some cases, you can type more characters in a box than can be displayed at one time. When the box is full, you can continue entering characters. The existing characters scroll to the left. When the characters in a box are highlighted, the new characters you type replace the existing characters.

You can use the following keys to edit the information you type in boxes.

**To do this**          **Press this key**
Move the cursor to the first character in the text box.          HOME
Move the cursor to the last character in the text box.           END
Move the cursor one character to the left.                      LEFT ARROW
Move the cursor one character to the right.                     RIGHT ARROW
Highlight existing characters. You can then press DEL or type a new character to delete the highlighted characters. SHIFT plus any of the preceding keys
Insert characters between existing characters (press again to type over existing characters). INS
Delete the character directly above the cursor.                  DEL
Delete the character to the left of the cursor.                  BACKSPACE
Move the cursor from one box to the next.                       TAB
Move the cursor to the previous box.                            SHIFT+TAB
Move from one box to the next.                                  UP or DOWN ARROW

If you have a mouse, you can use it to do the following:

- Click anywhere in the characters you’ve typed to move the cursor there.
- Click a different box to move the cursor there. If there is existing text in the box, it is highlighted.
- Drag left or right to highlight existing text. Then you can press DEL or another character to delete the highlighted characters.

**Selecting Options in a Dialog Box**

Some dialog boxes include one or more options. For example, suppose you choose the File Options command from the Options menu. The Shell displays the following dialog box.

![Dialog Box]

This artwork is not available for this release.

shb_21

In this box, the first two options are already selected. You can change the options by selecting or canceling them.
Using Program Manager

To select or cancel an option:

Mouse  ■ Click the option you want to change.

Keyboard  1. Press TAB or the ARROW keys to move to the option you want to change.
    2. Press the SPACEBAR.

Entering, Canceling, or Getting Help

Almost all dialog boxes have three buttons at the bottom. The OK button tells MS-DOS to perform the command using the information in the dialog box. The Cancel button cancels the command. The Help button displays information about the command.

To choose a button:

Mouse  ■ Click the button you want to choose.

Keyboard  1. Press the TAB or ARROW keys to move to the button you want.
    2. Press ENTER.
       You can choose OK by pressing ENTER. You can choose Cancel by pressing ESC. You can choose Help by pressing F1.

Using Program Manager

When you want your computer to perform a specific task, you tell it to follow a set of instructions called a program. Commonly used programs include word processors, spreadsheets, and database management systems. By using the MS-DOS Program Manager, you can run programs easily, without having to search through directories to find the files that contain them. By adding the programs you use most often to Program Manager, you can start each one with the click of a mouse or a few keystrokes.

In this section, you will learn the basic skills needed to use Program Manager. You will also find an overview of the commands in Program Manager menus.

Understanding the Program Manager Screen

Program Manager's selection area includes a list of programs you can choose. This list is called the Main group. When you first start using the Shell, the Main group includes the following programs:
This program          Does this

Command Prompt        Returns you to the command prompt
File Manager          Moves you to the Shell File Manager.
Change Colors         Changes the appearance of the Shell screens

The folder icon next to the DOS Utilities listing indicates that it is the title of a group of programs, rather than a single program (in text mode, programs are shown in uppercase letters and groups are shown in lowercase letters). You can view the programs in a group by selecting the name of the group.

Running Programs

You can run any program listed in the Main group or in any of the subgroups, by choosing it.

► To run a program from Program Manager:

**Mouse**
- Double click the program you want to run.
  Or click the program name once, and choose Start from the Program menu.
  If there is a long list of programs, and the program you want does not appear in the selection area, use the scroll bar to scroll to the program you want, and then double click it.

**Keyboard**
1. Use the ARROW keys to move the selection cursor to the program you want to run. If there is a long list of programs, press PAGE UP or PAGE DOWN to move more quickly.
2. Press ENTER, or choose Start from the Program menu.

You can also run programs from the File Manager menu by using the Open File command or choosing the file that contains the program from the appropriate disk and directory. For more information, see "XX".

The Shell lets you display a customized dialog box when you start running a program. For more information, see "XX".

Working with Groups of Programs

You can make programs easier to work with by organizing them into groups. A group is similar to a directory: it organizes the names of several programs in a
single location so you can find them easily. However, a group only organizes programs visually. Putting a program in a group does not change its directory location.

**Viewing a Group**

To run a program that is listed in a group, you display the group and choose the program you want.

- To display the list of the programs in a subgroup:
  - **Mouse**
    - Double-click the title of the group you want to view.
    - You can now run any of the programs listed in the group.
  - **Keyboard**
    1. Use the ARROW keys to move the selection cursor to the group you want to view.
    2. Press ENTER.
    - You can now run any of the programs listed in the group.

To return to the Main group, press ESC.

**Creating and Modifying Groups**

To create and modify groups of programs, use commands in the Group menu. You can use these commands to add new groups, change the information in existing groups, delete a group, or reorder the programs in a group.

<table>
<thead>
<tr>
<th>Use this command</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Add a group and specify its title, filename, and additional information.</td>
</tr>
<tr>
<td>Change</td>
<td>Change the information associated with a group.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete a group.</td>
</tr>
<tr>
<td>Reorder</td>
<td>Change the order of programs in a group.</td>
</tr>
</tbody>
</table>

For more information about creating and modifying groups of programs, see “XX”.

**Working with Programs**

You can add programs to any group by using the commands in the Program menu. You can give names to your programs and enter the commands MS-DOS needs to
run them. You can also add a help message to make a program easier to use, include a password to restrict access to a program, delete programs you don’t need any more, and change or copy the information for a program. The Program menu includes the following commands:

<table>
<thead>
<tr>
<th>Use this command</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Run a program (same as choosing it from the list).</td>
</tr>
<tr>
<td>Add</td>
<td>Add a program to the currently listed group.</td>
</tr>
<tr>
<td>Change</td>
<td>Change the information associated with a program.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete a program from the current group.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy a program to a different group.</td>
</tr>
</tbody>
</table>

For more information about adding programs, see "XX".

Moving from Program Manager to File Manager

To move from Program Manager to File Manager, choose FILE MANAGER from the Program Manager Main group.

Using File Manager

File Manager makes it easy for you to work with files, directories, and disks. You can use File Manager to:

- View the files stored in directories and on disk drives.
- Select one or more files from a directory.
- Choose commands from the File Manager menus to work with a disk drive, directory, file, or group of files you have selected.

In this section, you will learn the skills you need to move around the File Manager screen and select drives, directories, and files. You will also find an overview of the commands on the File Manager menus.

Understanding the File Manager Screen

The File Manager screen includes basic Shell screen elements, and includes several additional items.
This artwork is not available for this release.

shb_9

The disk-drive icons show which disk drive you are currently using.
The directory identifier shows which directory you are currently using.
The Directory Tree displays some or all of the directories on the currently selected drive, and shows you which directory is currently selected.
The file list displays some or all of the files in the currently selected directory, and shows you which files (if any) are selected.

Understanding File Manager Icons

In graphics mode, File Manager uses several icons to represent the types of information it lists. The icons and their meanings are listed below. Some icons are used
in both Program Manager and File Manager. In text mode, the Shell does not display icons.

This artwork is not available for this release

shb_10

Floppy disk drive

This artwork is not available for this release

shb_11

Hard disk drive

This artwork is not available for this release

shb_12

Directory

Beta Release
This artwork is not available for this release

shb_13

Program file

This artwork is not available for this release

shb_14

Non-program file

Selecting a Disk Drive

When you start the Shell, File Manager displays the contents of the disk drive that contains the command files for the Shell. If you are using a floppy disk system, this is probably the A drive. If you are using a hard disk, File Manager probably displays the C drive. To work with files on another drive, you select a drive icon from the File Manager screen. When you select a different drive, the Directory Tree and file list show the contents of the root directory on the new drive. If there are many directories on the new drive, the Shell displays a message while it sets up the Directory Tree: "Reading Disk Information . . ."

To change the current drive:

Mouse  ■ Click the drive you want to use.

Keyboard  1. Press TAB until one of the drive indicators is highlighted.
           2. Use the ARROW keys to move the highlight to the drive you want to use.
           3. Press ENTER.
If you change floppy disks when you are using the Shell, the file list will continue to display the files on the old floppy disk until you select the disk drive icon again using one of the above methods.

Selecting a Directory

When you select a directory other than the one currently displayed, the directory indicator changes to show the name of the new directory, the new directory is highlighted in the Directory Tree, and the file list displays the files in the new directory.

To select a directory:

Mouse

- Click the the name of the directory you want to select.
  
  If you have a long list of directories and the directory you want does not appear, use the scroll bar on the right side of the Directory Tree to scroll the directory you want into view, and then click it.

Keyboard

1. Press the TAB key until the selection cursor moves to the Directory Tree.
   
   If you are in graphics mode, you will not always be able to see the selection cursor when you use TAB to move to the Directory Tree. If you aren’t sure where you are on the File Manager screen, press the UP or DOWN ARROW key to see where the selection cursor is.

2. Use the UP ARROW and DOWN ARROW keys to move the selection cursor from one directory to the next.
   
   If you have a long list of directories, you can use the PAGE UP and PAGE DOWN keys to move more quickly.

3. When the selection cursor is at the directory you want, press the SPACEBAR.

There are many other methods you can use to display directories. For more information about displaying directories in the Shell, see "XX".

Selecting Files

Before choosing Shell file-management commands, you must select the files you want to use from the file list. The directory that contains the file or files you want to use must be displayed. (For more information about selecting a directory, see the preceding section.)
You select files by moving the selection cursor or by clicking files with the mouse. The Shell highlights the files you select. If you are using graphics mode, the icon next to a file changes color when you select it. In text mode, a small triangular pointer appears next to a selected file.

This artwork is not available for this release.

Selecting a Single File

To select a file:

Mouse  • Click the file you want to select.

If there is a long list of files, and the file you want does not appear, use the scroll bar on the right side of the file list to scroll the file you want into view, and then click it.
The Shell highlights files as you select them. In graphics mode, the selected file’s icon changes color. In text mode, a small triangular pointer appears next to the file you selected.

To cancel a selection, click it again.

**Keyboard**

1. Press the TAB key until the selection cursor moves to the file list.
   If you are in graphics mode, you will not always be able to see the selection cursor when you use TAB to move to the file list. If you aren’t sure where you are on the File Manager screen, press the UP or DOWN ARROW to see where the selection cursor is.

2. Use the UP ARROW and DOWN ARROW keys to move the selection cursor to the file you want to use. As you move, individual files are selected automatically.
   The Shell highlights files as you select them. If you are in graphics mode, the selected file’s icon changes color. If you are in text mode, a small triangular pointer appears next to the selected file.
   To cancel a selected file, press CTRL+SPACEBAR.

**Selecting a Group of Files**

You might want to select several files at once. Multiple selections are particularly useful when you want to delete or copy a number of files. You can select a group of files that are listed together or out of consecutive order in a directory. You can also select files from more than one directory at once.

▶ To select two or more files in consecutive order:

**Mouse**

1. Click the first or last file in the list you want to select.
2. Hold down the SHIFT key, and drag the highlight up or down until all the files you want are selected.
   To cancel the selection, click any file without holding down the SHIFT key.

**Keyboard**

1. Move the selection cursor to the first or last file in the list you want to select.
2. Hold down the SHIFT key.
3. Press the UP ARROW, DOWN ARROW, PAGE UP, and/or PAGE DOWN keys to move to the other end of the list.
   Without letting go of the SHIFT key, press the SPACEBAR to highlight all the files.
   To cancel the selection, press the SPACEBAR without holding down the SHIFT key.
This artwork is not available for this release.

shb_16

▶ To select two or more files that are not in consecutive order:

**Mouse**
- Hold down CTRL key while you click each file you want to select.
- To cancel the selection of an individual file, keep holding down the CTRL key and click the file you want to cancel.
- To cancel the selection of all the files, let go of the CTRL key and click any file.

**Keyboard**
1. Select the first file you want to select.
   - After you press this key combination, you can move the selection cursor without cancelling the selection of the first file.
3. Move the selection cursor to the next file you want to select.
4. Press CTRL+SPACEBAR to select each additional file.
   To cancel the selection of individual files, move to the file you want to cancel
   and press CTRL+SPACEBAR again.

5. Press SHIFT+F8 again when you have finished selecting files.
   To cancel the entire selection, choose Deselect All from the File menu.

**TIP** You can select a group of files with the keyboard or mouse by using the preceding
procedures, and holding down shift when you select a second file. All the files between the
first file and second file you selected are also selected.

► To select all the files listed in a directory at once:

   ■ Choose Select All from the File menu.

► To cancel all selections:

   ■ Choose Deselect All from the File menu.

► To select files from more than one directory at once:

   1. Choose File Options from the Options menu.
   2. Select the Select Across Directories option.
   3. Select one or more files from any directories on any drive.
   4. When you are finished, cancel the Select Across Directories option, to avoid
      accidentally selecting files you don’t want.

   For more information about using the Shell to work with files, see "XX".

**Running a Program from File Manager**

You can use File Manager to run programs, just as you can with Program
Manager.

► To run programs from File Manager:

  **Mouse**

   1. Double-click the file that contains the program you want to run.
   2. Choose OK in the Open File dialog box.
Using File Manager

**Keyboard**
1. Select the file that contains the program you want to run and press ENTER. Or choose Open (Start) from the File menu.
2. Type the name of the file that contains the program you want to run. If the dialog box already contains the filename, skip this step.
3. Press ENTER.

For more information about running a program from File Manager, see "XX".

**Using the File Manager Menus**

The File Manager includes four menus—File, Options, Arrange, and Tree—that provide commands for working with drives, directories, and files. This section provides a brief overview of the menus and the commands in them. You’ll find more detailed information about the commands later in this guide.

**File Menu**

The File menu contains commands you use to work with files. From this menu you can choose commands to copy, rename or delete files, move them from one directory to another, search for a file you’ve misplaced, look at the contents of a file, and perform other file-management tasks.

The following list describes each command in the File menu.

<table>
<thead>
<tr>
<th>Use this command</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open (Start)</td>
<td>Open or start a file.</td>
</tr>
<tr>
<td>Print</td>
<td>Print one or more files.</td>
</tr>
<tr>
<td>Associate</td>
<td>Link files to a program, so you can open a file and start the program at the same time.</td>
</tr>
<tr>
<td>Move</td>
<td>Move one or more files from one directory to another.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy one or more files to a different directory.</td>
</tr>
<tr>
<td>Search For</td>
<td>Search for one or more files anywhere on a disk drive.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete one or more files, or delete a directory if no files are selected.</td>
</tr>
<tr>
<td>Rename</td>
<td>Give one or more files a new name, or give a directory a new name if no files are selected.</td>
</tr>
</tbody>
</table>
Use this command | To do this
--- | ---
Change attribute | Set read-only, archive, hide, and system attributes for one or more files.
View | Display the contents of a file on the screen.
Create directory | Make a new directory.
Select all | Select all the files displayed.
Deselect all | Cancel all the selections.
Exit | Quit File Manager, and return to Program Manager.

Options Menu

You choose commands in the Options menu to modify options for displaying and working with files.

The following list describes each command in the Options menu.

Use this command | To do this
--- | ---
Display options | Change the number and order of files listed in directories.
File options | Confirm deletion and replacement of files, and select files across directories.
Show information | Shows file, directory and disk information.

Arrange Menu

You use commands in the Arrange menu to change the display of directories and files on the screen.

The following list describes each command in the Arrange menu.

Use this command | To do this
--- | ---
Single file list | Display the file list of a single directory.
Multiple file list | Display the file lists of two directories at the same time.
System file list | Display all the files on a drive in a single directory.
Tree Menu

You choose commands in the Tree menu to rearrange the layout of the Directory Tree.

The following list describes each of the commands in the Tree menu:

<table>
<thead>
<tr>
<th>Use this command</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand One Level</td>
<td>Display an additional level of subdirectories below the selected directory.</td>
</tr>
<tr>
<td>Expand branch</td>
<td>Display all the subdirectories of the selected directory.</td>
</tr>
<tr>
<td>Expand all</td>
<td>Display all the subdirectories in the Directory Tree.</td>
</tr>
<tr>
<td>Collapse Branch</td>
<td>Remove subdirectories of the selected directory from the display.</td>
</tr>
</tbody>
</table>

Help Menu

You choose commands in the Help menu to get information about the Shell.

<table>
<thead>
<tr>
<th>Use this command</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>Display information about the Shell.</td>
</tr>
<tr>
<td>Index</td>
<td>Display an index of Help topics.</td>
</tr>
<tr>
<td>Keys</td>
<td>Display information about using a keyboard with the Shell.</td>
</tr>
</tbody>
</table>

Moving from File Manager to Program Manager

To move from File Manager to Program Manager, press F3 or choose Exit from the File menu.

Getting Help

The MS-DOS Shell’s Help system provides information about menus, options, and commands.

To get help:
Press F1 at any time.
Or choose the Help button in any dialog box.
Or choose Help from the Help menu in either Shell screen.

When you choose Help, the Shell displays a Help dialog box, with information about the selected menu, command or dialog box.

For example, if you ask for Help when the Rename command is highlighted, the following dialog box appears.

This artwork is not available for this release.

If you want information about a topic other than the one currently displayed, choose the Index button in any Help dialog box or choose Index from the Help menu.

Beta Release
This artwork is not available for this release.

If you want information about how to use keys on your keyboard, choose the Keys button in any Help dialog box or choose Keys from the Help menu.
This artwork is not available for this release.

Leaving the Shell

You can leave the Shell and move to the MS-DOS command line in several ways. You can quit the Shell temporarily, work with the MS-DOS command line while the Shell is still in your system's temporary memory, and return to the Shell quickly. Or, you can quit the Shell and remove it from your system's temporary memory.

▶ To leave the shell temporarily:

- Choose COMMAND PROMPT from Program Manager.
  Or press SHIFT+F9.
Customizing the Look of the Shell

When you are ready to return to the Shell, type exit and press ENTER. The Shell re-appears almost immediately.

To quit the shell and remove it from temporary memory:

- Choose Exit from the Program menu in Program Manager.
  Or press F3 once (if you are in Program Manager) or twice (if you are in File Manager).

If you want to use the Shell again after removing it from the temporary memory, you can type dosshell and press ENTER.

For information about the MS-DOS command line, see "XX".

Customizing the Look of the Shell

You can use the Change Colors program in Program Manager Main group to change the way the Shell looks.

Changing Colors

If you have a color display, you can use the Change Colors program to change the colors used in the Shell’s screens. If you have a monochrome display, you can use the Change Colors program to change the dark and light colors used in the Shell’s screens.

To change screen colors:

1. Choose the Change Colors program from Program Manager Main group.
   You see a display of the colors currently in use, along with a dialog box:
This artwork is not available for this release.

2. Click the LEFT and RIGHT buttons shown on the screen to view other color choices.
   Or press the LEFT and RIGHT ARROW keys to view other color choices.
3. Choose OK to choose the color combination you want.

**Changing Screen Modes**

The Change Colors program also allows you to switch between the available text modes and graphics modes. For more information about the differences between these modes, see XX.

▷ To change between text and graphics mode:
1. Choose the Change Colors program from the Program Manager Main group. You see a display of the screen mode currently in use.

2. Click the UP and DOWN buttons shown on the screen to view other screen mode choices.
   Or press UP ARROW and DOWN ARROW to view other screen mode choices.

3. Choose OK to choose the screen mode you want.
Part 2
Working with MS-DOS

Beta Release
Files organize the information that your computer uses. MS-DOS itself is stored in a file that is read into memory when you switch on your system. While there are a number of different types of files, every file has a name and location that uniquely identifies it, and a group of attributes that describe it.

Types of Files

Much of the information stored in files is text such as letters, punctuation and special characters (*, @, and !). Other information stored in files is unreadable. For example, the programs that your computer runs are stored in a form that is readable only by the computer. Some files contain only text, some contain only unreadable data, and some contain both.

Because you perform different tasks with different types of files, it is important to be able to recognize five types of files and what they are used for.

Program Files

Program files contain the programs that your computer runs. All your applications are contained in program files. The files that contain programs always end with the letters .EXE. Lotus® 123®, for example, is stored in a file called 123.EXE.

The MS-DOS commands are also computer programs stored in program files. The files that contain commands end in .COM to distinguish them from other programs. Internal MS-DOS commands are stored together in a program file called COMMAND.COM.

In Chapter 9, “The Shell Program Manager,” you’ll learn how to use the MS-DOS Shell to organize and run your program files.
Types of Files

Specialized Data files

Many programs produce their own kinds of files that contain codes understandable only to the program that created them. These files may contain no text, some text, or mostly text.

For example, when you create a spreadsheet, the spreadsheet program saves the spreadsheet in a file that only it can read. Database programs and many computer games also produce specialized data files. Sometimes a program assigns a specific file extension to the files it creates. For example, Microsoft Word assigns the .DOC extension to its document files.

Unformatted Text Files

Unformatted text files contain only text. Almost all computer programs, including MS-DOS 5.0, represent text using a system called the American Standard Code for Information Interchange (ASCII). Often, files of this type have the .TXT file extension. If you use MS-DOS to work directly with text files, the files must contain only unformatted ASCII characters.

Formatted Text Files

Like unformatted text files, formatted text files use ASCII characters. However, formatted text files also contain codes that only the program can understand. These special codes tell the program how to format the text.

For example, you'll notice that not all the text is formatted the same (different fonts, paragraph styles, and so forth). In addition, the text is laid out in specific way (the page number is in a certain place, there is a certain amount of space between lines, and so on). The codes that determine how the text appears are stored along with the text in a formatted text file.

Batch Files

Batch files are unformatted text files that contain MS-DOS commands. If you often type the same set of commands to start a program, you can put them into a batch file. Then, instead of typing the commands each time, you can run the batch file, which enters the commands for you. Batch files always have a .BAT file extension. For more information on batch files, see Chapter 11, "Working With Batch Files."
Filenames

Every file has a name. The filename consists of a name and an extension. The name is always written first and the file extension is always separated from the name by a period, as in the following:

This artwork is not available for this release.

fil_1

Names

The name of a file identifies it. For example, the COMMAND.COM file contains MS-DOS commands and the MOUSE.SYS file contains information your system needs if you use a mouse. When you create a file, it's a good idea to give the file a name that clearly identifies its contents.
Filenames

The names you choose for files must:

- Be no longer than eight characters.
- Contain only the letters A through Z, the numbers 0 through 9, and the following special characters: underscore (_), caret (^), dollar sign ($), tilde (~), exclamation point (!), number sign (#), percent sign (%), ampersand (&), hyphen (-), curly brackets ( { ) and parentheses ( )
- Not contain spaces, commas, or periods (except the period that separates the name from the extension).
- Not use the following names because they are reserved by MS-DOS: clock$, con, aux, com, lpt, lst, nul, and prn.

Extensions

An extension identifies the type of file. Extensions are optional except in rare cases. However, if you don't use an extension, you, MS-DOS, or the programs you use might have trouble identifying the file.

MS-DOS uses the following extensions to identify its files:

- .EXE (executable) for files that contain programs
- .COM (command) for files that contain MS-DOS command instructions
- .SYS (system) for files that contain information about your hardware (for example your mouse and expanded memory)
- .BAT (batch) for files containing lists of MS-DOS commands that are automatically executed

When you create a file, you can choose an extension that helps you identify the file. Programs often suggest a specific extension. For example, Microsoft Word uses a .DOC extension to identify the text files that it creates. It is generally best to use the extensions suggested by your programs so that you and the program will later recognize the file.

The extensions you choose for files must be no longer than three characters. The filename restrictions about type of characters and spacing also apply to file extensions.
File Size and Time of Creation

In addition to filenames, MS-DOS stores information about their size and the time they were created. You can see this information by entering the dir command. For example, MS-DOS might display the following list in response to a dir command:

```
Volume in drive A is LARKA
Volume Serial Number is 1E51-12F8
Directory of A:\

BACKUP.COM  36800  04-07-8912:00a
DISKCOPY.COM  10396  04-03-8912:00a
FORMAT.COM  22876  04-07-8912:00a
KEYB.COM    14727  04-06-8911:40a
             4 File(s)  84879 bytes
             112384 bytes free
```

Next to the filename, MS-DOS displays the size of the file. Files are measured in bytes. One byte is the amount of space it takes to store a single character. A high-density floppy disk can store about 1.44 megabytes of information. A file's size tells you how much disk space you'll need to store the file.

To the right of the file size, MS-DOS displays the date and time the file was created or last changed. MS-DOS revises the date and time only when you change the contents of the file. The time and date do not change when you copy the file or rename it.

The size and time attributes help you keep track of your files. For example, you might want to know whether two files with different filenames contain the same information. One way to estimate if the two files are the same is to look at their sizes and dates. If the size, date, and time are the same for both files, it's likely that their contents are identical. If you want to be sure that two files are the same, use the fc command discussed later in this chapter.

When you are backing up files, you will often have two or more files on different disks with the same filename. You can use file sizes and dates to determine which file is the most recent.

Using MS-DOS Wildcards

If you want to do the same task on a group of files, it's inconvenient to enter the same command repeatedly with the name of each file in the group. For this reason, MS-DOS provides wildcard characters that let you specify groups of files. MS-DOS wildcards substitute for names or extensions.
Using MS-DOS Wildcards

There are two wildcards:

- The asterisk (*) wildcard represents whole words or groups of characters.
- The question mark (?) wildcard represents single characters.

Using Wildcards to Specify Groups of Files

Suppose the disk in drive A contains a portion of the MS-DOS command files. You would use the following dir command to display a list of all files on the disk:

```
dir a: /w
```

You could also display all the files on the disk with this command:

```
dir a:*.* /w
```

The *.* combination tells MS-DOS to display file regardless of their names or extensions. When you enter either of these commands, MS-DOS displays a list of files like the one shown below:

```
Volume in drive A is LARKA
Volume Serial Number is 1E51-12FB
Directory of A:\

AUTOEXEC.BAT  BACKUP.COM  COMMAND.COM  CONFIG.SYS  COUNTRY.SYS
DISKCOPY.COM  DISPLAY.SYS  EGA.CPI  FDISK.EXE  FORMAT.COM
KEYB.COM  KEYBOARD.SYS  LCD.CPI  MODE.COM  REPLACE.EXE
RESTORE.COM  SELECT.COM  SELECT.HLP  SELECT.PRTSELECT.DAT
SELECT.EXE  SYS.COM  XMA2EMS.SYS

23 File(s)  566862 bytes
77824 bytes free
```

You can use the MS-DOS wildcards to display selected groups of files from this list. For example, to see only files with the .COM extension, enter the following directory command:

```
dir a:*.*.com /w
```

MS-DOS lists the program files that have the .COM file extension:

```
Volume in drive A is LARKA
Volume Serial Number is 1E51-12FB
Directory of A:\

BACKUP.COM  COMMAND.COM  DISKCOPY.COM  FORMAT.COM  KEYB.COM
MODE.COM  RESTORE.COM  SELECT.COM  SYS.COM

9 File(s)  197439 bytes
77824 bytes free
```

To see only files with the name SELECT, you would enter the following directory command:

```
dir a:SELECT /w
```

78
dir a:select.* /w

MS-DOS lists the files with the name SELECT, regardless of their extensions:

Volume in drive A is LARKA
Volume Serial Number is 1E51-12FB
Directory of A:\

SELECT.COM SELECT.HLP SELECT.PRT SELECT.DAT SELECT.EXE
5 File(s) 151772 bytes
77824 bytes free

In addition to representing entire names or extensions, the asterisk (*) wildcard can substitute for parts of a name or extension. For example, to see files whose names begin with the letter C, enter the following command:

dir a:c.* /w

MS-DOS lists files whose names start with this letter regardless of the rest of the name or the extension:

Volume in drive A is LARKA
Volume Serial Number is 1E51-12FB
Directory of A:\

COMMAND.COM CONFIG.SYS COUNTRY.SYS
3 File(s) 50459 bytes
77824 bytes free

If you use the asterisk wildcard to copy or delete files, be careful you don’t specify a group of files instead of a single file. For example, if you have a file called MYTES.TXT and another named MYSALE.TXT, both will be copied to drive A by the following command:

copy my*.txt a:

Unlike the asterisk (*) wildcard, which substitutes for any or all characters in a name or an extension, the question mark (?) wildcard represents single letters. For example, to list the files that have up to three-letter names, enter the following command:

dir a:???.* /w

MS-DOS lists files with up to three-letter names, regardless of the actual name or extension:

Volume in drive A is LARKA
Volume Serial Number is 1E51-12FB
Directory of A:\

SYS.COM EGA.CPI LCD.CPI
3 File(s) 71227 bytes
77824 bytes free
Using Wildcards to Match Files

You can use wildcards to match one file or group of files with another. For example, to make all the files on drive A with a .BAT extension have a .BAK extension you could use the following ren (Rename) command:

```
* .bat * .bak
```

MS-DOS uses the first wildcard differently from the second. It uses the first to find all files that have a .BAT extension; it uses the second to create a name that matches the old name of each .BAT file.

To copy files on drive A that have names beginning with F and .BAT extensions to files on drive B with identical names but .BAK extensions, you could use the following copy command:

```
copy a: f*.bat b:* .bak
```

Displaying Text Files

**In Brief**

To see the contents of a file, use the type command. For example, the following command displays the LIST.TXT file in drive B:

```
type b:list.txt
```

Use the type command to look at the contents of files that contain text. (You can look at the contents of other kinds of files too. However, only the text will be readable.) When you enter the type command, MS-DOS displays the entire file on your screen. You cannot change the text or display only a portion of the file.

For example, you can use the type command to see the contents of the AUTOEXEC.BAT file. AUTOEXEC.BAT is the batch file that tells MS-DOS what to do when you start your system. If you have a hard disk, you'll find the AUTOEXEC.BAT file in the root directory of drive C. If you have a floppy disk system, you'll find it on the disk you use to start your system.

With a floppy disk, you can display the AUTOEXEC.BAT file by putting the disk you use to start your system in drive A and entering the following command:

```
type a:autoexec.bat
```

With a hard disk, enter this command:

```
type c:autoexec.bat
```

80
MS-DOS displays the entire file. If a file contains more information than will fit on the screen, MS-DOS scrolls the text more quickly than you can probably read it.

**TIP** To temporarily pause the display of a file, press **CTRL+S** or the key labeled **PAUSE** while the file is scrolling. The display will stop scrolling until you press any key. You can also use the **more** command to display one screen of text at a time.

If you accidentally tell MS-DOS to display a file that is very long, or of the wrong sort, enter **CTRL+C** or **CTRL+BREAK** to cancel the **type** command rather than waiting for it to finish displaying the file.

**Shell**

To display a file:

1. Select the file you want to see from a file list on the File Manager screen.
2. Choose View from the File menu.
   MS-DOS displays the File View screen with the file you selected.
3. Use the **PAGE UP** and **PAGE DOWN** keys, or the **ARROW** keys, to view the contents of the file.
   Press **F9** to switch between viewing the file as ASCII text and as hexadecimal code.
4. Press **ESC** when you are finished viewing the file.

**Copying Files**

The **copy** command is your primary tool for organizing and making copies of files. With the **copy** command you can:

- Copy a file from one directory or disk to another.
- Copy a group of files by using the MS-DOS wildcards.
- Rename files as you copy them.
- Combine two or more files into a single file.

For information about copying entire disks, see section XX in Chapter 7, "Managing Disks."
CAUTION When you use the copy command, be sure you avoid inadvertently destroying a file by copying over it. For example, if you copy a file called SCORES.DAT to a directory that already has a file by that name, MS-DOS replaces the existing file with the copy.

Copying Single Files

In Brief

To copy a file to another disk or directory, use the copy command. For example, the following command copies the PROB.DBS file from drive A to drive B:

    copy a:prob.dbs b:

When using the copy command, you type the location and filename of the file you want to copy from, followed by the location and filename of the file you want to copy to. The first file is called the source file and the second file is called the destination file.

For example, to copy the OUTGO.XLS file from drive A to drive B, enter the following command:

    copy a:outgo.xls b:outgo.xls

MS-DOS makes a copy of the OUTGO.XLS file on drive A and puts it on drive B in a file with the same filename. If you want the source and destination files to have the same filename, you can omit the destination file. For example, the following command does the same as the previous example:

    copy a:outgo.xls b:

As MS-DOS copies a file, it displays the filename on your screen. If you don’t use wildcards to copy files, MS-DOS displays a message that tells you how many files were copied, as in the following:

    A:OUTGO.XLS
    1 File(s) copied

If you decide after entering the command that you don’t want to copy the file, you can cancel the command while it is in progress by pressing CTRL+C.

When MS-DOS can’t find the file you want to copy, it displays a “File Not Found” message. Check to see that you typed the filename correctly and that the file is in the correct directory.
Copying a Group of Files with Wildcards

In Brief
To copy a group of files from one disk or directory to another, use the copy command with wildcards. For example, the following command copies all the files with a .DBS extension from the current directory to drive B:

```plaintext
copy *.dbs b:
```

Suppose you have a number of files on drive A that you designated as temporary by giving them a .TMP file extension (for example, PLACE.TMP, GUESTS.TMP, TASKS.TMP, and so forth). If you want to copy these files to a disk in drive B, you can use the following command:

```plaintext
copy a:* .tmp b:* .tmp
```

DOS copies all the files with the .TMP extension to the disk in drive B.

You might have a group of files with filenames that differ only slightly. To copy them you can use the question mark (?) wildcard. For example, suppose you created four reports called JAN1RPT.DOC, JAN2RPT.DOC, JAN3RPT.DOC, and JAN4RPT.DOC and stored them on the disk in drive A. To transfer the files to drive B, you could use the following command:

```plaintext
```

DOS copies the files on drive A that have seven letter names that begin with the letters JAN, end with the letters RPT, and have a .DOC extension.

If the disk you are copying to runs out of space, MS-DOS stops copying and lists the files that were copied. For example, if the disk in drive B ran out of room after two of the four .DOC files were copied, you would see a display like this:

```
JAN1RPT.DOC
JAN2RPT.DOC
JAN3RPT.DOC

Insufficient disk space 3 File(s) copied
```

To verify that a copy is an exact duplicate of the original, use the /v switch. For example, to make sure that the four .DOC files in the previous example are copied accurately to drive B, add the /v switch to the end of the command:

```plaintext
```

MS-DOS rereads the information it copies to make sure that it matches the original exactly. If there are no differences, MS-DOS displays a message verifying that the copy is error-free. Using the /v switch will slow down your system.
Renaming as You Copy

*In Brief*

To rename a file as you copy, specify the new name as in the following command:

```
copy prob.dbs b:noprob.dbs
```

If you want to assign a new name to a file you are copying, specify the new filename as the destination file. (If you want to rename a file without making a copy, use the rename command discussed later in this chapter.)

For example, to copy the file OUTGO.XLS from drive A to drive B and rename it EXPEND.XLS on the disk in drive B, use this command:

```
copy a:outgo.xls b:expend.xls
```

You can rename groups of files by using wildcards. If you want the .TMP files on drive A to have an .OLD file extension on drive B, use the following command:

```
copy a:*.*.tmp b:*.*.old
```

You can copy a file to the same directory if you rename the file. If you don't rename the file when copying to the same directory, MS-DOS displays the following message:

```
File cannot be copied onto itself
0 File(s) copied
```

Combining Files with the Copy Command

*In Brief*

To combine two or more files into a single file, include a plus sign (+) between the files you want to combine as in the following command:

```
copy prob.dbs + dob.dbs probdob.dbs
```

You can use wildcards to combine groups of files:

```
copy *.dbs all.dbs
```

You can use the copy command to combine two or more unformatted text files into a single file. For example, the following command joins the file A:SCENE1.TXT and A:SCENE2.TXT into a new file called B:ACT1.TXT:

```
copy a:scene1.txt + a:scene2.txt b:act1.txt
```

MS-DOS joins the files in the order you type them. In this example, MS-DOS adds SCENE2.TXT to the end of SCENE1.TXT.
If you don't specify a destination file, MS-DOS replaces the first file you typed with the combined file. For example, to include the SCENE3.TXT file at the end of the ACT1.TXT file, you would enter this command:

```
copy act1.txt + scene3.txt
```

**Copying from the Keyboard and to the Printer**

**In Brief**

To copy text from the keyboard to a printer, first create a text file using the `copy` command followed by the word CON, as in the following example:

```
copy con prob.dbs
```

To print the file, copy it to the port to which your printer is attached, as in the following command:

```
copy prob.dbs lpt1
```

You can use the `copy` command to copy from your keyboard to a file and to print the file. To copy from your keyboard, specify CON as the source file and a filename as the destination file. In effect, your keyboard becomes the source file. For example, the following command allows you to type directly into the NOTE.TXT file on drive A:

```
copy con a:note.txt
```

The command tells MS-DOS to copy whatever you type on the keyboard to the file A:NOTE.TXT. When you enter the command you'll notice that MS-DOS moves to the next line and displays a cursor with no command prompt. While the command is active, MS-DOS copies what you enter at the keyboard directly into the file. As usual, if A:NOTE.TXT does not exist, MS-DOS creates it. If it does exist, what you type replaces what is already in the file.

When you are finished typing into the file, press CTRL+Z to close the file and display a command prompt.

**NOTE**  You can use the command editing keys described in Chapter 8, "Advanced Command Techniques," to edit the line of text you are typing, but after you press ENTER you can't change text on previous lines.

To copy a file to your printer, specify the name of the port to which the printer is attached as the destination file. (For more information about ports, see "Printing Files", later in this chapter.) For example, the following command copies the NOTE.TXT file on drive A to the printer attached to the LPT1 port:
Renaming Files

    copy a:note.txt lpt1

Using CON and the name of a port, you can copy directly from your keyboard to a printer, for example, to the printer attached to the LPT1 port:

    copy con lpt1

When you are finished typing to the printer, press CTRL+Z to print what you have typed and display a command prompt.

Copying Files with the Shell

You can use the File Manager copy command to copy any number of files from one directory to another. If you have chosen Confirm on Replace from the Options menu, MS-DOS asks you to confirm the copy if you are copying over an existing file.

NOTE  Do not use Program Manager copy command to copy files. The Program Manager command is a tool for organizing how files are displayed; it doesn't make copies on disk. For more information on using the Program Manager, see Chapter 9, "The Shell Program Manager."

Shell  ➩  To copy files:

1. Select the file or files you want to copy from a file list on the File Manager screen.
2. Choose Copy from the File menu. The Copy File dialog box appears, with the filenames you selected in the From box.
3. Type the location of the directory where you want to copy your files in the To box.
4. Choose OK.

Renaming Files

In Brief  ➩  To rename a file, use the rename command (also called the ren command), as in the following example:

    ren mytax.dat ourtax.dat
To change the name of a file without changing its location, use the `rename` command. This command is especially helpful for organizing files. For example, suppose you have two versions of a file called PRICES.LST. The version on the disk in drive A contains last year's prices, whereas the version on drive C is current. To avoid confusion between the two files, you can use the following command to rename file that contains last years prices:

```
ren a:prices.lst prices.old
```

MS-DOS wildcards can help you rename groups of files. For example, suppose you use the .TXT extension to identify your WordPerfect® files. To rename the .TMP files discussed in the previous sections so that they become .TXT files, you could use the following command:

```
ren *.tmp *.doc
```

MS-DOS changes the file extension of each file in the current directory that has a .TMP extension (PLACE.TMP becomes PLACE.TXT, GUESTS.TMP becomes GUESTS.TXT, and so on).

**Shell**

To rename files:

1. Select the file or files you want to rename from a file list on the File Manager screen.
2. Choose Rename from the File menu.
   - The Rename File dialog box lists the current name of the first file you selected.
3. Type the new filename in the New name box.
4. Choose OK.
   - If you selected more than one file, the Rename File dialog box asks you to rename each file separately. When all the files are renamed, File Manager is ready to accept new commands.

**Printing Text Files**

You can print unformatted text files from MS-DOS with the print command. It is generally best to print formatted text files and other specialized files from the program you used to create them. For information about formatted and unformatted text files, see “Types of Files” earlier in this chapter.

MS-DOS gives you print options that an application may lack. Unlike some applications, MS-DOS lets you start a print job and then go on to other tasks while the
Printing Text Files

printer prints. In addition, MS-DOS lets you specify a list of files to print so you don’t have print each file separately.

Before printing, make sure your printer is properly connected to your system, that it’s switched on, and that it’s online. For information about readying your printer, consult your printer documentation.

Printing Files

**In Brief**

To print an unformatted text file from MS-DOS, use the `print` command, as in the following example:

```plaintext
print config.sys
```

If you don't specify a port, MS-DOS assumes LPT1 (also called PRN). To specify a port other than LPT1, use the `/d` switch, as in the following command:

```plaintext
print config.sys /d:com1
```

Suppose you have a file named TOGO.TXT that you want to print. If your printer is attached to the LPT1 port, enter the following:

```plaintext
print togo.txt
```

If your printer is attached to another port, add a `/d` switch to specify the port. For example, if printer output is normally directed to LPT1, use this command to send the TOGO.TXT file to a laser printer attached to COM1 port:

```plaintext
print togo.txt /d:com1
```

The `/d` switch is always separated from the name of the port by a colon (`:`).

To print more than one file at a time, you can type the various filenames separated by spaces, or you can use the MS-DOS wildcards described earlier in this chapter.

**Shell**

To print files:

1. Select one or more files from a file list on the File Manager screen.
2. Choose Print from the File menu.
   - The Shell adds the files to the print queue.
Using the Print Queue

In Brief

To view the contents of the print queue, use the print command with no parameters as in the following example:

```
print
```

To stop printing and empty the print queue, use the /t switch, as in this command:

```
print /t
```

The MS-DOS print queue is a list of the files waiting to print. The file at the top of the queue is the one currently being printed. MS-DOS adds your files to the print queue when you use the print command. After the first file is finished printing, MS-DOS advances the printer paper to the next sheet and begins printing the second file.

To see what's in the queue, enter a print command with no parameters:

```
print
```

MS-DOS lists the files in the queue and tells you which one is currently printing.

To cancel all printing and empty the print queue, use the /t switch:

```
print /t
```

MS-DOS stops sending information to the printer. The printer will keep printing until it has used up all the information it has stored.

NOTE The print queue requires memory that MS-DOS and your applications could otherwise use. Therefore, using the print queue may affect the efficiency of your system. To print without the print queue, use the copy command described earlier in this chapter.

Deleting Files

As you work with MS-DOS, you'll occasionally want to clean out files that are no longer useful. You can delete a single file, selected groups of files, or all files in a directory or on a disk. Once you've deleted them, files are irrevocably gone. Be sure that the files you specify for deletion are indeed the ones you want to throw away.
Deleting Files

Deleting Single Files

In Brief

To remove a file from a disk permanently, use the del command (also called the erase command), as in the following example:

```
del a:temp.exe
```

You delete a single file by entering the del command, followed by the location and name of the file you want to delete. For example, to delete the TEST.TMP file on the disk in drive B, enter the following command:

```
del b:test.tmp
```

MS-DOS permanently removes the file from the disk. Instead of del, you can enter erase. For instance, the following is equivalent to the previous example:

```
erase b:test.tmp
```

If you add the /p switch to the del command, MS-DOS gives you a chance to check your filename, as in the following message:

```
TEST.TMP, Delete (Y/N)?
```

Enter y if you want to delete the specified file or n if you want to cancel the command.

Deleting Groups of Files

In Brief

To delete a group of files use the del command with wildcards as in the following example:

```
del temp.*
```

You can use MS-DOS wildcards to delete groups of files that have similar filenames. For example, if you want to delete files from their original location after you copy them, use the asterisk (*) wildcard. For example, the following command deletes all files with the .TMP file extension on the disk in drive A:

```
del a:*.*
```

Before using wildcards to delete a group of files, it's a good idea to use the dir command to display the files that match your wildcard description. Developing this habit may prevent you from accidentally deleting files you intended to keep. For more information about the dir command, see Chapter 6, "Working with Directories."
Clearing a Directory

In Brief

To delete all files in a directory, use the `del` command with the "*.*" wildcard combination as in the following example:

```
del b:*.*
```

If you want to clear a directory that contains files you no longer need, you can delete all files by entering the following command:

```
del a:*.*
```

In response to any "*.*" wildcard entry, MS-DOS asks you to confirm that you want to delete all files. If you are sure you want to throw away the files, enter `y`. As a result, MS-DOS deletes every file in the current directory of the disk in drive A.

Deleting Files with the Shell

You can use the `Delete` command in the Shell to delete one or more files.

Shell

To delete files:

1. Select the file or files you want to delete.
2. Choose `Delete` from the File menu.
   - If you’re using the Program Manager, the Delete Item dialog box appears.
   - If you’re using File Manager, the Delete File dialog box appears.
3. Choose `OK` to delete the files.
   - If you are using File Manager and have chosen `Confirm on Delete` from the Options menu, MS-DOS prompts you for confirmation before it deletes each file.

Moving Files

In Brief

To move a file from one disk or directory to another, use the `copy` command, then the `del` command, as in the following example:

```
copy a:outgo.xls b:
del a:outgo.xls
```
Comparing Files

Using the copy and del commands, you can move one or more files from one directory or disk to another. Moving files requires you first to copy them to their new location. After copying the files, delete them from their original directory. For example, to move the group of .TMP files discussed earlier from the disk in drive A to the disk in drive B, use the following two commands:

```
copy a::*tmp b::*tmp
del a::*tmp
```

Shell ➤ To move files:

1. Select the file or files you want to move from a file list on the File Manager screen.
2. Choose Move from the File menu.
   The Move File dialog box appears, listing the file or files you selected in the From box.
3. In the To box, type the location of the directory where you want to move the file. If you want to rename the file in its new location, type the new filename after the location of the directory.
4. Choose OK.

Comparing Files

In Brief

To see if two files or groups of files have the same contents, use the fc command as in the following example:

```
f /a a:mytax.dat b:
```

MS-DOS compares the files and displays differences.

Comparing file size and time of creation is an approximate way of determining whether or not two files are identical. To get a precise comparison of two files, use the fc command. For example, suppose you have an unformatted text file called FOODPRP.TXT on two disks. To find out if the files are exactly the same, put one disk in drive A and the other in drive B and enter this command:

```
f /a a:foodprp.txt b:
```
MS-DOS starts at the beginning of the two files and compares each byte. When it finds a difference, MS-DOS displays the line that begins a set of differences, an ellipsis, and the line that ends the set of differences, as in the following:

```
*****foodprep.txt
Our expected revenues for the month of January is expected to rise
...when the results are not yet certain.
*****foodprep.txt
Our expected revenues for January are less than projected
...when the results are not yet certain.
*****
```

For more information on the fc command, see the *MS-DOS 5.0 User’s Reference*.

### Viewing and Changing File Attributes

Every file has four qualities associated with it that help you back it up and protect it from being seen or changed. These qualities, called file attributes, do the following:

- The *archive* attribute (a) is used with the backup and xcopy commands to control which files are backed up. See Chapter 7, “Managing Disks,” for a discussion of backing up files.

- The *read-only* attribute (r) protects a file by preventing it from being changed or deleted. When a file has this attribute, you can look at the file but you cannot delete it, rename it, or change its contents. You’ll see how to give a file this attribute later in this section.

- The *hide* attribute (h) tells MS-DOS not to display a file in directory lists. The file remains in a directory, but cannot be used unless you know its filename. This attribute is useful if you are working on sensitive files that people should not see. To learn more about the hide attribute, see the attrib command in the *MS-DOS 5.0 User’s Reference*.

- The *system* attribute (s) tells MS-DOS to make a file a system file. Files with the system attribute are not shown in directory listings. To learn more about the system attribute, see the Attrib command in the *MS-DOS 5.0 User’s Reference*.

**NOTE** No files are hidden from the file list in the Shell File Manager screen.
Viewing and Changing File Attributes

Viewing File Attributes

**In Brief**

To view the access and backup attributes of a file, use the `attrib` command as in the following example:

```
attrib outgo.xls
```

MS-DOS displays the filename and the attributes of the file.

To see a file's attributes, enter the `attrib` command followed by the filename. For example, the following command shows you the attributes of the `CONFIG.SYS` file on drive A:

```
attrib a:config.sys
```

MS-DOS displays up to four attributes in front of the filename. For example, if `CONFIG.SYS` has the archive and read-only attributes, MS-DOS displays the following:

```
a r config.sys
```

You can see the attributes for a group of files using the MS-DOS wildcards. This command shows you the attributes of all files in the root directory of drive C:

```
attrib c:\*.*
```

**Shell** To view the attributes of a file:

1. Select the file from a file list on the File Manager screen.
2. Choose Show Information from the Options menu.

MS-DOS displays the Show Information dialog box, which lists the file's attributes along with other information about the file.

3. Choose OK when you are finished viewing the attributes.

Changing a File Attribute

**In Brief**

To assign or remove an attribute from a file, include the attribute's letter and a plus or minus sign respectively. For example, the following command makes the `OUTGO.XLS` file read only:

```
attrib +r outgo.xls
```

94

Beta Release
When you want to be sure that the contents and name of a file will not change, assign a read-only attribute to the file. For example, suppose you have spent three weeks getting your spreadsheet, GEMINI.XLS, just right. You want to let other people use it, but you don't want them to change it. To make sure that the file cannot be altered, you could put its disk in drive B and enter this command:

```
attrib +r b:gemini.xls
```

Later, if you decide that you want to change the file, you can remove the read-only attribute with this command:

```
attrib -r b:gemiini.xls
```

You can use the MS-DOS wildcards to assign and remove the read-only attribute from groups of files.

For information about using other file attributes, see the MS-DOS 5.0 User's Reference.

**Shell**

To change the attributes of a file:

1. Select the file or files you want to change from a file list on the File Manager screen.
2. Choose Change Attribute from the File menu.
   MS-DOS displays the Change Attribute dialog box.
3. Choose option 1 if you want to change attributes of each file you selected individually. Choose option 2 if you want to change the attributes of all the files at once.
   MS-DOS displays another Change Attribute dialog box that shows the file you selected and its present attributes.
This artwork is not available for this release.

4. Choose the attribute you want to change or assign to the file or files listed in the box.
   A mark appears next to the attribute to show that it is assigned.
   To cancel a selection, choose it again.
5. Choose OK.

Finding Text Within a File

In Brief

To display the lines of a file that contain a specified group of words, use the find command, as in the following example:
find "Error" output.txt

To display only the number of lines that contain the text you specify, include the /c switch:

find "Error" output.txt /c

The text you specify must be identical in capitalization and spacing to the text in the file.

If you want to search one or more files for a group of words, you can use the find command. For example, if your personal phone book is in the PHONE.TXT file, you can use the following command to display all lines of the file that contain the text Area Code: 206:

find "Area Code: 206" phone.txt

MS-DOS searches the PHONE.TXT FILE and displays each line that has the text Area Code: 206. You must enclose the text in quotation marks. MS-DOS finds only text that exactly matches the characters you specify, including capitalization and spacing. If the text in the file has formatting codes (for example, if the words Area Code are underlined), MS-DOS won't match the specified text.

You cannot use wildcards to search more than one file, but you can list all the files you want to search when you enter the command. For example, the following command searches the PHONE.TXT file as well as the ADDR.TXT file:

find "Area Code: 206" phone.txt addr.txt

If you just want to know how many lines of the file contain the text, use the /c switch. For example, the following command tells you how many lines of the ADDR.TXT file contain the text Bellerose:

find "Bellerose" addr.txt /c

If you want the results of the find command to be stored in a file rather than displayed on the screen, you can use the greater-than sign (>) to redirect the output. For example, the following command stores the result of the find command in the NWEST.NUM file:

find "Area Code: 206" phone.txt >nwest.num

For information on using redirection characters, see Chapter 8, "Advanced Command Techniques."
Using the Shell to Search for Files

Using the Shell File Manager, you can locate files with the Search command. The Search command searches the directory selected or the entire current disk for the file or files you specify. Once you have located the files, you can use any of the commands on the File menu to work with the files you have found.

**Shell**

To search for a file:

1. Choose Search from the File menu on the File Manager screen.
   MS-DOS displays the Search File dialog box.

This artwork is not available for this release.
2. Type the name of the file you want to find.
   You can search for a single file by typing its name or you can use MS-DOS
   wildcards to search for files with similar names.

3. Clear the Search Entire Disk check box if you want MS-DOS to search only
   the current directory for the files.
   If the Search Entire Disk option is selected (if the box preceding it contains an
   X), MS-DOS searches through every directory on the currently selected disk.
   If you have two directories displayed and two disks selected, MS-DOS
   searches the disk selected on the upper half of the screen.

4. Select OK  to begin searching for the file or files you specified.
   MS-DOS displays a list of files that match the one you specified. You can
   select files from this list and work with them using the commands on the File
   menu.

**Using the Shell to Get Information About a File**

When you have one or more files selected from a file list in the File Manager, you
 can display the Show Information dialog box to get information about the file, its
directory, and its disk.
Using the Shell to Get Information About a File

This artwork is not available for this release.

fil_4

The File section of the box shows the filename and attributes of the file you selected. The attributes are (a) archive, (r) read-only, and (h) hidden file. For more information about file attributes, see the "MS-DOS 5.0 User's Reference."

The Selected section of the box shows the number of selected files on the current disk and their combined total size. If you have worked with two different disks, the Selected section has two columns: one for the most recently selected disk, and one for the previously selected disk.

The Directory section of the box lists the name, size, and number of files in the directory that contains the file you selected.

The Disk section of the box lists the name, size, amount of available space, and the number of files and directories on the disk that contains the file you selected.
Shell  ▶ To get information about a file:

1. Select the file you want information about from the file list on the File Manager screen.
2. Choose Show Information from the Options menu.
   MS-DOS displays the Show Information dialog box.
3. Choose Cancel when you are finished viewing information.

Using the Shell to Associate a File with a Program

If you have a set of files that you often use with a particular program, you can save time with the Associate command in the File menu. This command associates one or more file extensions with a program. When you open a file that has one of the extensions you specified in the Associate command, MS-DOS runs the associated program automatically, and the file is loaded into the program.

For example, suppose you normally do word processing with WordPerfect, which has a program file named WP.EXE. If you assign a .TXT extension to the documents you create with WordPerfect, you can use the Associate command so that MS-DOS automatically starts WordPerfect when you open a .TXT file.

You can associate up to 20 different file extensions with one program. When you choose a file that has any of the extensions, the program runs and loads the file. You can associate an extension with only one program at a time. For example, you can’t associate the extension .TXT with WordPerfect and another word processing program at the same time.

Shell  ▶ To associate one or more files with a program:

1. Select the program file you want to associate with the file extension (or extensions) from the file list.
2. Choose Associate from the File menu.
   The Associate File dialog box appears.
3. In the box, type the file extension (or extensions) that you want to associate with the program.
Using the Shell to Associate a File with a Program

NOTE  Don't type a period at the beginning of the extensions you type in the box. To associate more than one extension with a program, type the extensions with one or more blank spaces between each one.

4. Choose ENTER.

The program is now associated with the file extension or extensions you specified.

If you occasionally want to run a file with a program other than the one it is associated with, use the Open command from the File menu to specify a new program.

Shell ➤ To run an associated file with a different program:

1. Select the file you want to use from the file list.
2. Choose Open from the File menu.
   The Open File dialog box appears.
3. Type the path and filename of the new program you want to run with the file.
4. Choose ENTER.

If you’ve associated a program with a file extension, you can remove the association.

Shell ➤ To delete the association between a program and a file:

1. Select the program.
2. Choose Associate from the File menu.
3. When the Associate File dialog box appears, erase the file extension or extensions you no longer want to associate with the program.
4. Choose ENTER.
Chapter 6

Working with Directories

You can think of your disks as cabinets where you keep your files. Like a file cabinet, your disks have folders that group the files that belong together. These folders are called directories. You use directories to organize files. When you have a number of files that you want to keep together, you can put them in their own directory.

In a file cabinet, when a folder contains so much information that you can no longer easily find what you want, you subdivide it. For example, if your sales folder becomes large, you might add folders to separate the files by month. In the same way, when your directories get too large, you can divide them into subdirectories.

Understanding Directories

Directories provide a way of organizing files into groups. Directories are most important when you use a hard disk. If you use only floppy disks, you can usually keep files separate by putting them on different disks. With a hard disk, which may contain as much information as dozens of floppy disks, it becomes necessary to organize files into categories so you can find them more easily. A hard disk with no directories is like a large file cabinet with no dividers.

The Directory Tree

Every disk has at least one directory. When you format a floppy or hard disk, MS-DOS creates a directory where all other files and directories will be stored. This directory is called the root directory.

You create subdirectories of the root directory to organize and separate files. For example, you could put all of your Microsoft Paint files in one directory and all of your Microsoft Word files in another directory. You can picture this directory structure as an upside-down tree with 2 branches:
This artwork is not available for this release.

dir_1

You can create subdirectories within subdirectories to further organize your files. For example, suppose you use Microsoft Paintbrush for work, school projects, and personal projects. To keep your files separate, you can create three subdirectories in the Paintbrush directory. You can put your work files in the WORK directory, your school files in the SCHOOL directory, and your personal files in the HOME directory. You can picture the resulting directory structure as a tree with two main branches and three sub branches:
This artwork is not available for this release.

dl_r_2

You can continue to add directories at any level of the structure until your files are organized to your satisfaction. In this way, you create a directory tree that lets you quickly locate the files you need.

In general, there can be no more than 512 files and directories in the root. In other directories, you can have as many files and directories as you like. However, MS-DOS runs slower if there are more than about 150 files and subdirectories in a directory.

Strictly speaking, all directories other than the root directory are subdirectories. However, it is usually most convenient to use the term directory. In this manual, the term subdirectory is used only to emphasize the relationship between two directories. Subdirectories are sometimes called child directories, and a directory that contains subdirectories is sometimes called the parent directory.
Directory Names

Except for the root directory, which is always represented by a backslash (\), each directory has a name. The names you choose for directories must follow these rules:

- Directory names must be between one and eight characters long.
- Directory names can have a three-character extension that is separated from the directory name by a period.
- Directory names and extensions can contain the letters A through Z, the numbers zero through nine, and the following special characters: underscore (_), caret (^), dollar sign ($), tilde (~), exclamation point (!), pound sign (#), percent sign (%), ampersand (&), hyphen (-), curly brackets ({}), and parentheses ( ).
- Directory names cannot contain spaces, commas, periods, or backslashes.
- Two subdirectories of the same directory cannot have the same name. For example, the WORD directory cannot have two subdirectories named FILES. However, subdirectories of different directories can have the same name. For example, you can have a subdirectory named FILES in both the PBRUSH directory and the WORD directory. (You can even have a subdirectory of the WORD directory called WORD, although it would be very confusing.)
- It is best to keep directory names short because MS-DOS will not recognize pathnames that are more than 64 characters long.

In addition its own name, the current directory is called "." (period) by MS-DOS. The parent directory of the current directory is called ".." (double period). MS-DOS recognizes these names if you substitute them for the real names of either of these directories.

Paths and Pathnames

The path is the location of a file within the directory tree. You can think of it as the route that MS-DOS must travel, starting at the root, to get to files in the directory. For example, suppose that the hard disk in drive C has this directory tree:
This artwork is not available for this release.

To get to files in the FINAL directory, MS-DOS must go into the following directories: Root (\), PBRUSH, SCHOOL, and FINAL.

In MS-DOS commands, you name the path in the following way:

\pbrush\school\final

This is the path of the FINAL directory. The first backslash represents the root directory; the other backslashes separate the various directory names.

If you want MS-DOS to find the FINAL directory, you type the path of the directory. To specify the FIG1.MSP file in the \PBRUSH\SCHOOL\FINAL directory, you add another backslash and the filename to the path:

\pbrush\school\final\fig1.msp
Understanding Directories

There may be more than one file called FIG1.MSP in other directories and there may be other directories called \PBRUSH\SCHOOL\FINAL on other disks. For this reason, to fully distinguish a file from all other files, you must add a drive letter to the path and filename. For example, the full designation for the FIG1.MSP file in the \PBRUSH\SCHOOL\FINAL directory on the disk in drive C is:

c:\pbrush\school\final\fig1.msp

The drive, directory path and filename for a file are the file’s *pathname*. If you want to be absolutely sure that you are using the correct file, you can always type pathname of the file. However, because MS-DOS has a current drive and a current directory, you don’t always have to type a file’s full pathname.

The Current Drive

MS-DOS assumes that you want to use the directory tree on the current drive unless you tell it otherwise. The letter of the current drive is usually shown as part of the command prompt. For example, if the current drive is A, you can delete the A:\FIG1.MSP file with the following command:

del fig1.msp

You do not have to type the letter of the current drive.

There can be only one current drive at a time. To work with files on a drive other than the current one, you can either type the other drive letter or change the current drive by entering a new drive letter followed by a colon (:). For example, to make drive A current, enter A:.

The Current Directory

One directory on each disk in your system is current. Often MS-DOS displays the path of the current directory as part of the command prompt. Like the current drive, you don’t have to type the path of the current directory because MS-DOS assumes you want to work with it. For example, if C is the current drive and \PBRUSH\SCHOOL\FINAL is the current directory, you can delete the C:\PBRUSH\SCHOOL\FINAL\FIG1.MSP file with this command:

del fig1.msp

Because C is the current drive and \PBRUSH\SCHOOL\FINAL is the current directory, you don’t have to type them.

Every drive has a current directory. Even if a drive is not current, it still has a current directory. For example, if the \PBRUSH\SCHOOL\FINAL directory is current on drive C and the \FIGS directory is current on drive A, you could use the
following command to copy the FIG2.MSP file from A:\FIGS to C:\PBRUSH\SCHOOL\FINAL:

```
copy a:\fig2.msp c:
```

Unless you tell it otherwise (by typing a specific path), MS-DOS assumes that you want to work with the current directory on each drive. When you start your system, all of the current directories are set to the root directories of the drives in your system.

To work with files in a directory that is not current, you have three choices:

- You can type the path of the other directory.
- You can make the other directory current using the `cd` command. This command is described in "xx," later in this chapter.
- You can include the path of the other directory in the `path` command. This command is described in "xx," later in this chapter.

If you want to type the path of another directory, you need only include the part of the path that is different from the path of the current directory. For example, if the current directory is `\PBRUSH\`, you can enter the following command to delete the `\PBRUSH\SCHOOL\FINAL\FIG1.MSP` file:

```
del school\final\fig.msp
```

Because the file you want to delete is in a subdirectory of the current directory, you don't have to type the complete path. If the file is not in a subdirectory of the current directory, you have to type its entire path. For example, if the current directory is `\WORD`, to delete `\PBRUSH\SCHOOL\FINAL\FIG1.MSP`, you would have to enter this command:

```
del \pbrush\school\final\fig.msp
```

### Using the Prompt Command to See the Current Directory

You can use the `prompt` command to change the command prompt so it always displays the current directory. Unless you tell it otherwise, MS-DOS uses the current drive followed by the greater than sign (`>` as the command prompt. For example, the following prompt tells you that the current drive is `A`:

```
A>
```

You can use various options with the `prompt` command to change the way your prompt looks. For example, the following command tells MS-DOS to display the current drive and directory as the command prompt:

```
prompt $p
```
Viewing Directories

If the current directory is \CAPBRUSH, MS-DOS displays this prompt:

C:\PBRUSH

The following command creates a prompt that contains the current drive and
directory and a greater-than sign (>) to separate the prompt from the command
you type:

prompt $p$s

If the current directory is \CAPBRUSH, MS-DOS displays this prompt:

C:\PBRUSH>

NOTE If you use $p to create a prompt that displays the current drive and directory, MS-
DOS will check the directory after every command. This may cause a small delay if your
current drive contains a floppy disk. To return the prompt to its original value (the greater-
than sign (>) preceded by the current drive), enter this command:

prompt

If you change the prompt, it will return to its original form each time you start
your system.

To change the prompt automatically each time you start the system, you can in-
clude a prompt command in your AUTOEXEC.BAT file. If your prompt contains
more than just the current drive when you start your system, there is already a
prompt command in your AUTOEXEC.BAT file. For more information, see xx.

For information about the other options you can use with the prompt command,
see the MS-DOS User's Reference.

Viewing Directories

To see the files that are in any directory on any disk, you can use the dir com-
mand. The simplest form of the command displays a list of the files in the current
directory. By adding to the command, you can tell MS-DOS to:

- Display only some of the files in a directory.
- Show the directory one screen at a time.
- Arrange the way files are displayed in the directory listing.
Displaying Whole Directories

In Brief

To view the contents of a directory, use the dir command. For example, the following command displays the contents of the C:\WORD directory:

```
dir c:\word
```

The dir command without its options lists the files in the current directory. For example, if your current directory is A:\ you can use the following command to see its contents:

```
dir
```

MS-DOS displays the following information about the A:\ directory and the files it contains:

```
This artwork is not available for this release.
```

dir_4

Beta Release
Viewing Directories

For more information about each element in a directory listing, see xx. If you add the path of a directory to the command, MS-DOS displays the files in the specified directory rather than in the current directory. No matter which directory is current, the following command shows you the files in the root directory of the disk in drive B:

`dir b:\`

When you want to see the contents of a subdirectory, you must include the backslash that represents the root directory. For example, this command displays the files in the WIN subdirectory on drive C:

`dir c:\win`

Displaying Groups of Files

In Brief

To display a group of files in a directory listing, include wildcards with the `dir` command. For example, the following command displays all of the files in the current directory that have a `.COM` extension:

`dir *.com`

MS-DOS assumes that you want to see all the files in the directory unless you tell it otherwise. To display only some of the files in a directory, you can use the MS-DOS wildcards. For example, to see a list of the files in the root directory of the disk in drive B that have a `.DOC` file extension, enter the following command:

`dir b:*.*`

To list the files in a subdirectory called WIN on drive C that have filenames beginning with JAN, use this command:

`dir c:\win\jan*.`n

Notice that the filename is separated from the directory name by a backslash (`\`).

Arranging the Display of a Directory

In Brief

To display a directory one screen at a time use the `/p` switch, as in the following command:

`dir c:\win /p`

To display an abbreviated directory, with only filenames listed, use the `/w` switch:

`dir c:\win /w`

112

Beta Release
Often a directory is too long to be displayed on a single screen. To display a directory one screen at a time, use the /p switch, as in the following command:

```
dir /p
```

After displaying the first screen of files, MS-DOS pauses. To continue the display, press any key.

If you include the /w switch with the dir command, MS-DOS displays only the names of the files in the directory. With this switch you can usually see all of the files on a single screen. For example, the following command displays the contents of the root directory of drive C:

```
dir c:\ /w
```

MS-DOS displays up to five columns of filenames.

**Sorting a Directory Listing**

**In Brief**

To sort the directory listing by filename (n), extension (e), date (d), or file size (s) use the /o: switch. For example, the following command alphabetizes the listing by file extension:

```
dir c:\win /o:e
```

This command alphabetizes the listing in reverse order (from Z to A):

```
dir c:\win /o:-e
```

You can tell MS-DOS to sort a directory listing by including the /o: switch. The following list shows the various ways you can sort the directory:

- `/o:n` alphabetizes the directory by name.
  `/o:-n` reverse alphabetizes the directory by name (z to a).
- `/o:e` alphabetizes the directory by extension.
  `/o:-e` reverse alphabetizes the directory by extension (z to a).
- `/o:d` numbers the directory by date (oldest first).
  `/o:-d` numbers the directory by date (youngest first).
- `/o:s` orders the directory by file size (smallest first).
  `/o:-s` orders the directory by file size (largest first).
Viewing All Directories on a Disk

For example, the following command displays the directory of drive B with the largest file first:

```
dir b: /o:-s
```

You can combine switches. For example, this command alphabetizes the directory of C:\ and displays the filenames in five columns:

```
dir c:\ /on /w
```

Viewing All Directories on a Disk

In Brief

To display the relationship between a directory and its subdirectories, use the tree command. For example, the following command displays the relationship between the C:\WIN directory and its subdirectories:

```
tree c:\win
```

The following command uses the /f switch to include files in the display.

```
tree /f
```

The easiest way to see the relationship between the directories on a disk, or between a directory and its subdirectories, is to use the tree command. You can also see subdirectories with the dir command, but the tree command gives you more information. The dir command usually lists only the first level of subdirectories, while the tree command lists all the levels. The dir command displays the subdirectories along with files in a list on your screen, while the tree command displays the relationship between a directory and its subdirectories graphically, showing how each level fits.

For example, to see the subdirectories of the current directory, you would enter the following command:

```
tree
```

MS-DOS displays a directory tree graphic like this one:
This artwork is not available for this release.

dir_5

To see the tree structure starting at the root directory of the current drive, enter this command:

```plaintext
tree \n```

If you would like to see the files in each directory of the tree, include the /f switch. For example, this command displays the directories with all their files on drive C:

```plaintext
tree c:\ /f
```

**Viewing Directories in the Shell**

The Shell File Manager screen is divided into two parts. The left side of the screen shows the directory tree for the current disk. The right side of the screen shows the files in the selected directory. Using the File Manager commands, you...
can change the way files and directories are displayed on the screen and perform file and directory operations. In addition, you can split the screen horizontally to see two directory trees and file lists simultaneously.

Using the File Manager Directory Tree

When you first start the File Manager, the tree displayed on the left side of the screen includes only the root directory and the first level of subdirectories. The root directory is displayed at the top of the directory tree area of the screen. Subdirectories of the root directory are listed below the root directory. Additional subdirectories are listed below their parent directories. The display shows the relationship between parent directories and subdirectories. Each directory has a folder icon next to it that provides information about the directory's subdirectories (in text mode, a set of brackets appears instead of an icon).
This artwork is not available for this release.

dir_6

If a directory's icon is blank, that directory has no subdirectories. For example, in the preceding illustration the ???, ???, and ??? directories have no subdirectories.

If the icon contains a plus sign (+), the directory has subdirectories that are not displayed. For example, in the preceding illustration the ???, ???, and ??? directories have subdirectories that are not displayed.

If the icon contains a minus sign (-), the directory has subdirectories that are displayed. In the preceding illustration only the root directory's subdirectories are displayed.

You can change the subdirectory display by changing these icons with the keyboard or mouse, or by choosing the commands in the Tree menu.
Modifying Directory Icons

You can display subdirectories of a directory or remove directories from the display by changing a directory’s icon. When you change a directory’s icon from plus to minus to add its subdirectories to a display, the Shell only the next level of subdirectories. When you change a directory’s icon from minus to a plus, the Shell removes the subdirectories from the display.

NOTE Removing subdirectories from the display by changing a directory’s icon does not affect the subdirectories or their contents.

Shell ➤ To change a directory’s icon (and its subdirectory display):

- Click the icon of the directory you want to change, or double click the directory name.
  Or select the directory and press ENTER.
  The subdirectory display changes when you change the icon.

Working with the Tree Menu

You can use commands in the File Manager’s Tree menu to display subdirectories, or remove subdirectories as follows.

<table>
<thead>
<tr>
<th>Command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand One Level</td>
<td>Displays one level of subdirectories of the selected directory.</td>
</tr>
<tr>
<td>Expand Branch</td>
<td>Displays all levels of subdirectories of the selected directory.</td>
</tr>
<tr>
<td>Expand All</td>
<td>Displays all the subdirectories in the tree.</td>
</tr>
<tr>
<td>Collapse Branch</td>
<td>Removes the subdirectories of the selected directory from the display.</td>
</tr>
</tbody>
</table>

To display the level of subdirectories directly beneath the selected directory, choose Expand One Level from the Tree menu.

For example, suppose the selected directory contains three subdirectories, and each of these has two subdirectories of its own. If you choose Expand One Level, the three subdirectories are displayed. The subdirectories of the newly-displayed directories are not displayed.
This artwork is not available for this release.

dir_7

The Expand One Level command is equivalent to changing a directory icon from plus to minus.

To display all the subdirectories of the currently selected directory, choose Expand Branch from the Tree menu.

For example, suppose the selected directory has three subdirectories, and each of these subdirectories has two subdirectories of its own. If you choose Expand Branch, all nine subdirectories directories are displayed.
Viewing Directories in the Shell

This artwork is not available for this release.

dlr_8

To display all the subdirectories on the drive, choose Expand All from the Tree menu. Expand All works no matter which directory is selected.
This artwork is not available for this release.

NOTE Use the UP ARROW, DOWN ARROW, PAGE UP, and PAGE DOWN keys, or the scroll bar on the right side of the directory tree, to scroll up and down a long list of directories.

To remove the subdirectories of the currently selected directory from display, choose Collapse Branch from the Tree menu.

For example, if you select the root directory and choose Collapse Branch, all subdirectories are removed from display.
Rearranging the Shell Display

You can change the way the File Manager displays directory trees and file lists using the options on the File Manager’s Arrange Menu.

Displaying Two Directories at Once

When you first move to the File Manager screen, the files are in a single file list. To see and compare the contents of two directories, whether on the same drive or two different drives, use the Multiple File List command on the Arrange menu.
To see the contents of two directories, choose Multiple File List command from the Arrange menu.

The screen displays two drive indicators, two directory trees, and two file lists.

This artwork is not available for this release.

You can use the TAB key or the mouse to move from one drive, directory, and file display to the other. You can change drives and directories in each display, and select files in either file list.

To select files from both file lists at once, select the Select Across Directories option in the File Options command. For more information about the Select Across Directories option, see "XX".
Displaying All the Files on a Disk

The System File List command in the Arrange menu shows you all the files in all of your directories and a summary list of system information.

To display a system file list, choose the System File List command from the Arrange menu. The System file list appears.

This artwork is not available for this release.

dir_12

The system file list provides the following information:
### Information | Description
--- | ---
File | The filename and type of file you have selected. The attributes are: (a) archive, (r) read-only, and (h) hidden file. You assign these attributes with the Change Attribute command in the File menu.
Selected | The number of selected files on the working disk and their combined total size. You may see two columns, with the previously selected drive also represented.
Directory | The name, size, and number of files in the directory you have selected.
Disk | The name, size, amount of available disk space, and number of files and directories on the disk you have selected.

**Returning to a Single File List**

You can return to the standard single file list format by choosing Single File List from the Arrange menu.

**Modifying File Lists**

You can display a selected group of files in a directory's file list or display the files in a different order by choosing the Display Options command from the Options menu. These modified file lists can make it easier for you to find and work with files in a long file list.

**Displaying a Group of Files**

You can display a specific group of files in a file list. To display a group of files, choose Display Options from the Options menu and type a combination of MS-DOS wildcards and characters in the Display Options dialog box.

For example, to display only files with an .EXE extension:

1. Choose Display Options from the Options menu.
2. The Display Options dialog box appears.
3. Type *.exe in the Name: box.
4. Choose OK or press ENTER.
   The files with an .EXE extension are displayed in the file list.
Creating Directories

**TIP** After you've changed the display to show a group of files, you can easily show all the files again by choosing Display Options, pressing DEL, SPACEBAR or BACKSPACE to clear the Name box, and choosing OK or pressing ENTER.

For more information about MS-DOS wildcards, see “XX”.

**Sorting a Directory Listing**

You can use the Display Options command to rearrange the order of files in a file list. You can reorder files in the following ways:

- by file name, in alphabetical order
- by file extension, in alphabetical order
- by creation date, in chronological order starting with the file created most recently
- by the number of bytes in the file, from largest to smallest
- by the order in which the files are stored on disk

**Shell**  ▶ To change the order of the files in a file list:

1. Choose the Display Options command from the Options menu.
   A dialog box appears.
2. Choose the sort option you want.
3. Choose OK or press ENTER.
   The file list appears in the order you selected.

Files are sorted by name unless you specify otherwise. Once you change the sort order in the Display Options dialog box, files will be sorted in the order you selected until you change it again. If you are working with a multiple file list, both lists will be reordered.

Creating Directories

**In Brief**

To create a directory, use the `md` command (also called `mkdir`). For example, if the `\WIN\EXCEL` directory already exists, the following command creates the directory `\WIN\EXCEL\FINANCE`:

126  Beta Release